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Ventilation 

Basic simulation 

Principles 

The purpose behind the simulation of ventilation is to compute air quantities Q for each airway (i.e. 

the volume of air passing through an airway per time unit) in a standard ventilation mode, that is, in 

the situation when all parameters of the airflow are stabilized. In this case, to provide different 

consumers with required amounts of air means to design ventilation in such a way, as to ensure a 

minimum air quantity in every airway while keeping air velocities (determined by Q and an airway 

cross-sectional area) within the legal limits. 

Here the information on how airways are connected, their aerodynamic resistances R (the value 

defining a pressure drop in an airway due to the effort of air to pass through it) and fan pressures is 

a necessary condition for the calculation. The aerodynamic resistance R of an airway is connected 

with the pressure drop H via the squared Q described by a formula 𝐻 =  𝑅 ∙ 𝑄2, since the airflow is 

mainly turbulent, rather than laminar. Therefore, the task of ventilation simulation is the following 

one. The software should select air quantities Q to satisfy two conditions: 1) the sum of input air 

quantities should be equal to the sum of output air quantities in every node (Kirchhoff's first law); 2) 

an overall pressure drop at any closed circuit in the airway network should be equal to zero, that is, 

fan pressures should be compensated by pressure drops due to aerodynamic resistances of the 

airways (Kirchhoff's second law). 

Aerodynamic resistance types 

There are three ways to define the aerodynamic resistance: by design parameters, by data from a 

ventilation survey and manually. Once a pressure drop and an air quantity in an airway or a bulkhead 

are measured, then the second method being more accurate is preferable. Otherwise, a user should 

provide design data, which helps at least to evaluate the resistance. However, if the aerodynamic 

resistance cannot be estimated based on design parameters, then manual setting of resistance 

should be used, for example, for a pithead, where no formula to calculate its resistance by design 

parameters is known. 

The total aerodynamic resistance of an airway includes its own aerodynamic resistance as well as 

the sum of resistances of all bulkheads located in the airway. Along with that, the calculation method 

for each resistance is chosen on a case-by-case basis. For example, the aerodynamic resistance of 

an airway can be defined by design data, while the resistance of a bulkhead within it - by data from a 
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ventilation survey. It is especially useful, when a user should compare possible design solutions for 

a ventilation network constructed on actual measurements. 

Setting airway resistance by design data 

To evaluate the aerodynamic resistance of an airway by design data the software applies the Darcy-

Weisbach formula with airway length 𝐿, cross-sectional area 𝑆 and perimeter 𝑃, gravity acceleration 

𝑔, and k-factor, which is supposed to be determined only by the type of the airway surface (i.e. by the 

method of airway development). 

𝑅 =
𝑘 ∙ 𝐿 ∙ 𝑃

𝑔 ∙ 𝑆3
 

In this case, with standard values of k-factor a user can estimate the aerodynamic resistance of an 

airway, if its length, cross-sectional area and perimeter are known. Standard values of 𝑘 can be found 

in the dictionary, which can be opened by clicking the button on the left side of the corresponding 

field (Ventilation tab on the property panel of an airway). 

 

 

By default, airway length is calculated by the screen size on the schema and the current scale of 

physical coordinates. However, the calculated length can be substituted with a value set manually, 

which is especially helpful, when some parts of the schema are drawn with distortion (for example, 

the case may be for ventilation shafts). 
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As for the cross-sectional area of an airway, it is often known and determined by the type of mining 

machine. Standard cross-sectional areas can be found in the dictionary, which is opened by clicking 

the button near to the field. 

 

 

Cross-sectional area and its shape define the perimeter of an airway cross-section. The smallest 

perimeter value corresponds to a round airway, that is why the perimeter field does not permit to 

enter a value less than the perimeter of the circular cross-section for the selected area. As for other 

cross-section shapes, they are available in the dictionary, where the ratios of perimeters of different 

cross-sections to the square root of their areas are preset. 

 

Setting bulkhead resistance by design data 

There are two methods to define the aerodynamic resistance of a bulkhead by design data: by the 

area of an orifice for a regulator and by air permeability for a seal. 
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Zhukovsky's formula is applied to find the aerodynamic resistance of a regulator. At first, the 

following equation is solved. 

tan(𝛼) ∙ (1 +
4 ∙ 𝛼

𝜋 ∙ tan(2 ∙ 𝛼)
) =

𝑆𝑤

𝑆
 

𝑆𝑤 – area of the round orifice 

𝑆 – cross-section area of the airway 

Then the aerodynamic resistance 𝑅 is calculated. 

𝜃 =
𝜋

𝜋 +
4 ∙ 𝛼

tan (2 ∙ 𝛼)

 

𝑅 = (
𝑆

𝑆𝑤 ∙ 𝜃
− 1)

2

∙ 𝜌 

𝜌 – air density 

To find the aerodynamic resistance of a seal the design value of its air permeability is applied. 

𝑅 =
1

𝑝2 ∙ 𝑆2
 

𝑝 – air permeability of the seal 

𝑆 – cross-sectional area of the airway (equal to the area of the seal) 

By default, the air permeability of a seal is defined by its type. Standard air permeabilities for each 

type are edited in the dictionary, which is available on the Ventilation ribbon tab. 
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Along with that, the standard values can be taken from the dictionary, which is opened by clicking the 

button near the air permeability field. 

 

If air permeability is specified for each type of seal, then for a particular seal it is automatically 

inserted. 

 

However, this value can also be defined manually. 
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Airway types 

It often happens that a ventilation network consists of a great number of airways, which makes it very 

difficult to set design parameters for each of them. Therefore, it is advisable to group parameters of 

identical airways in one airway type. In this case, design parameters of airways can be changed 

centrally as well as visualized on the schema. 

The editor of airway types is available on the Ventilation ribbon tab. 

 

To add a new airway type a user should simply start typing its name in the corresponding field. 

 

Each airway should have a name, a shape, a cross-sectional area, a wall surface type, a maximum 

legal air velocity and a color for visualization on the schema. By default, the lists of cross-section 

shapes and surface types are empty, but they can be populated from the dictionaries. Besides, the 

editor of cross-section shapes allows typing user's values, if none of the reference values is suitable. 

In this case, a user should specify a shape factor calculated by the following formula. 

𝐾 =
𝑃

√𝑆
 

𝑃 – perimeter of the airway cross-section 

𝑆 – airway cross-sectional area 

As a result, the perimeter of an airway cross-section can always be calculated precisely from its 

cross-sectional area. Besides, a user can specify a range of permissible areas. In this case, an airway 

cross-sectional area is checked, and if its value is not within the range, then the airway type changes 

to the unknown one. 
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K-factors are preset in the same way in the editor of surface types. 
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One of the airway types can be marked as the default one. If so, it will be automatically assigned to 

new airways. 

As a result, with the filled dictionary of airway types a user does not have to specify individual airway 

properties, but rather just select an appropriate airway type from the list. 

 

In this case, the fields with the properties of cross-section, aerodynamic resistance and maximum 

legal air velocity are automatically filled. Besides, a user can select colors of airway types on the 

schema (View-> Ventilation-> Input Data -> Airway Type’s Color Inside). However, a user can still edit 

all these fields resulting in changing the airway type into the "User-defined" one. 
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As for airway length, by default it is calculated by coordinates, although a user can define it manually 

as well. Manual definition of airway length can be especially useful, when the airway itself is drawn 

with some distortions on the schema, which is not a rare case for long airways, for example, shafts. 

If an airway length is marked as manually defined, then by default it will contain the value of length 

calculated by coordinates. Later this value can be changed, but if the need of restoring the default 

length arises, it can be done by emptying the length field before saving. 

Fan types 

All fans are simulated by placing the objects on airways from the corresponding category. 

 

There are two fan types: simple and detailed one. 

 

A simple fan creates a fixed pressure, which is independent from any other parameters. Setting the 

fan efficiency can help to estimate its power.  It may especially be useful, when a user starts from a 

simple ventilation model. A detailed fan does not require one to specify the pressure manually, but 

rather calculates it by such design parameters, as fan curves, a blade angle, rotation frequency, etc. 

Editing detailed fans 

Design parameters for detailed fans are defined in the editor available on the Ventilation ribbon tab. 
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To create a template for a new fan, a user should click the Create Fan button. In this case, all 

parameters of the fan must be set manually. An alternative way to create a fan is to add it from the 

dictionary by clicking the Import Fan button. 

 

A user can set the fan's name, diameter of its blades, minimum and maximum speed and a set of 

curves. Each curve is a dependency of fan's pressure or power on the air quantity for a particular 

blade angle. These curves are obtained from manufacturers and are approximated in the application 

using parabolas defined by three points. The first point must determine fan's pressure and power for 

the minimum working air quantity, which denotes the starting point for surging. The third point must 

correspond to fan's pressure and power for the maximum working air quantity. The second point can 

be located anywhere between the first and the third points, and it should determine the bending of 

the pressure and power curves. If power curves are represented by the values of fan’s efficiency, then 

such values can be entered directly, instead of converting them to the values of fan’s power. 
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Parameters of a fan placed on an airway 

When a detailed fan is placed on an airway, then a user should, first of all, select an appropriate 

template from the fan editor. 

 

Then the user can select one of the blade angles with preset pressure and power curves for the 

selected fan template. Besides, it is necessary to define the fan's speed within the limits set in the 

template. If a particular fan speed is selected, then the fan's pressure 𝐻(𝑞) and power 𝑊(𝑞) curves 

are calculated in the following way. First, the curves 𝐻0(𝑞) and 𝑊0(𝑞) for the default fan's speed 𝑛0 

specified in the fan's template are selected. Then these curves are recalculated for the actual fan's 

speed 𝑛 by the following formulas. 

𝐻(𝑞) = 𝐻0(𝑞 ∙
𝑛0

𝑛
) ∙ (

𝑛

𝑛0
)
2

 

𝑊(𝑞) = 𝑊0(𝑞 ∙
𝑛0

𝑛
) ∙ (

𝑛

𝑛0
)
3
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Fan installation types 

Fan's pressure is influenced by both the design parameters of the fan itself and its installation in an 

airway. 

 

If a fan is installed "Inside a wall", that is, air inevitably passes a fan while moving along the airway, 

then its final pressure 𝐻(𝑞) and power 𝑊(𝑞) curves are unchanged. However, if a fan is a part of an 

ejector ("Before mixing chamber") or is installed "Without a wall", then 𝐻(𝑞) and 𝑊(𝑞) should be 

adjusted. 

Ejector-type fan parameters 

Ejector is a fan installed in front of a tube called mixing chamber with a larger diameter than an outlet 

diameter of a fan, that is why the output airflow entraps the air, which passes around the fan, into the 

tube. This helps significantly increase the air quantity through an ejector, provided the ventilated area 

resistance is not strong. If a fan worked inside a bulkhead, the air quantity would be limited by the 

fan’s maximum working air quantity. An ejector, in its turn, provides multiple increase of air quantity 

in an airway in comparison with the quantity inside a fan. 

 

If we suppose that the overall impulse of airflow passing through an ejector changes by the value of 

an impulse transferred to the air passing through the fan, then the following formula to calculate the 

final pressure could be determined. 

Convergent 

tube 
Fan 



16 

First, it is necessary to identify the value of air quantity 𝑞 passing directly through the fan. If the fan 

is not equipped with a special device called a convergent tube narrowing the leaving airflow, then the 

fan is supposed to function with its maximum legal air quantity preset in the template. Once a 

convergent tube is installed, then it creates additional aerodynamic resistance 𝑅𝑘, and the quantity 

𝑞 will be below the maximum. In this case, to calculate 𝑅𝑘 the respective formula from Handbook of 

Hydraulic Resistance by I. E. Idelchik is used.  

𝜒 = (−0.0125 ∙ (
𝑆𝑘

𝑆𝑓
)

4

+ 0.0224 ∙ (
𝑆𝑘

𝑆𝑓
)

3

− 0.00723 ∙ (
𝑆𝑘

𝑆𝑓
)

2

+ 0.00444 ∙
𝑆𝑘

𝑆𝑓
− 0.00745) × 

× ((0.01745 ∙ 𝛼𝑘)3 − 2 ∙ 𝜋 ∙ (0.01745 ∙ 𝛼𝑘)
2 − 10 ∙ (0.01745 ∙ 𝛼𝑘)) 

𝑅𝑘 =
𝜒 ∙ 𝜌

2 ∙ 𝑔 ∙ 𝑆𝑘
2 

𝑆𝑘 – area of the convergent tube outlet hole. 

𝑆𝑓 – area of the fan cross-section. 

𝛼𝑘 – convergence angle of the tube. 

𝜌 – air density. 

𝑔 – gravity acceleration. 

Notice that in the ejector properties a user should define not the convergence angle 𝛼𝑘, but the 

convergent tube outlet diameter 𝐷𝑘 and the tube length 𝐿𝑘, where 

𝛼𝑘 = 2 ∙
𝜋

180
∙ atan (

𝐷𝑓 − 𝐷𝑘

2 ∙ 𝐿𝑘
) 

𝐷𝑓 is the fan diameter. 

 

Then the application calculates the air quantity inside the fan with the convergent tube resistance 𝑅𝑘 

as a root of the following equation. 

𝐻(𝑞) = 𝑅𝑘 ∙ 𝑞2 

𝐻(𝑞) is the pressure curve of the fan being a part of the ejector. 

The pressure curve of the ejector 𝐻𝑘(𝑞) is calculated by the following formula. 
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𝑎 =

[
 
 
 

1

𝑆
,     𝑖𝑓 𝑄 ≥ 0

1

𝑆𝑐ℎ𝑎𝑚𝑏𝑒𝑟
 , 𝑖𝑓 𝑄 < 0

 

𝑏 =

[
 
 
 

1

𝑆𝑐ℎ𝑎𝑚𝑏𝑒𝑟 − 𝑆𝑘
,     𝑖𝑓 𝑄 − 𝑞 ≥ 0

1

𝑆 − 𝑆𝑘
 , 𝑖𝑓 𝑄 − 𝑞 < 0

 

𝑑𝑝1 = 𝑄2 ∙ (
1

𝑆𝑐ℎ𝑎𝑚𝑏𝑒𝑟
−

1

𝑆
) ∙ 𝑎 

𝑑𝑝2 = (𝑄 − 𝑞)2 ∙ (
1

𝑆𝑐ℎ𝑎𝑚𝑏𝑒𝑟 − 𝑆𝑘
−

1

𝑆 − 𝑆𝑘
) ∙ 𝑏 

𝑑𝑝3 =
1

𝑆𝑐ℎ𝑎𝑚𝑏𝑒𝑟
∙ (

(𝑄 − 𝑞)2

𝑆𝑐ℎ𝑎𝑚𝑏𝑒𝑟 − 𝑆𝑘
+

𝑞2

𝑆𝑘
−

𝑄2

𝑆𝑐ℎ𝑎𝑚𝑏𝑒𝑟
) 

𝐻𝑘(𝑞) =
𝜌

𝑔
∙ (𝑑𝑝1 − 𝑑𝑝2 + 𝑑𝑝3) 

𝑆 – cross-sectional area of the airway. 

𝑆𝑐ℎ𝑎𝑚𝑏𝑒𝑟 – cross-sectional area of the mixing chamber. 

𝑆𝑘 – area of the convergent tube outlet hole (or the fan’s area, if no convergent tube is available) 

𝑞 – air quantity inside the fan. 

𝑄 – overall air quantity in the airway. 

𝜌 – air density. 

𝑔 – gravity acceleration. 

It may happen so that the mixing chamber is assembled without a wall, so the air can make a circle 

by moving from a fan through the mixing chamber and back to the fan. 

 

Generally, a wall with a mixing chamber inside is supposed to have some known resistance 𝑅 (it is 

very large with a solid wall, and it is zero with no wall at all). In this case, the overall aerodynamic 

resistance of the wall 𝑅𝑓𝑢𝑙𝑙 can be calculated with due regard to airflow compression/expansion. 

Fan 
Convergent 

tube 
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𝑅𝑓𝑢𝑙𝑙 = 𝑅 +
1

𝜌 ∙ 𝑔
∙ (

1

𝑆 − 𝑆𝑐ℎ𝑎𝑚𝑏𝑒𝑟
−

1

𝑆𝑐ℎ𝑎𝑚𝑏𝑒𝑟
)
2

 

Having calculated 𝑅𝑓𝑢𝑙𝑙 , the application finds the air quantity 𝑞𝑏, which returns back through the wall 

by solving the following equation. 

𝑞𝑏 = √
𝐻𝑘(𝑄 − 𝑞𝑏)

𝑅𝑓𝑢𝑙𝑙
 

With 𝑞𝑏 the final pressure curve of the ejector can be calculated by the following formula. 

𝐻𝑘(𝑄) = 𝐻𝑘(𝑄 − 𝑞𝑏) 

Fans in series and parallel 

Sometimes several fans are placed together. In that case, there are two ways to install them: in series 

and parallel. In the case of fans in series, the air passed through one of the fans goes to the next one, 

each of which increases the total pressure head. In order to install fans in series on the schema a 

user should place them on the same airway. 

 

In the case of fans in parallel, each of the fans takes only a part of the total airflow. In order to install 

fans in parallel on the schema, a user should place them on parallel airways, if there are ones, 

otherwise, such airways should be created having zero aerodynamic resistance. 

 

If fans in parallel have identical parameters, then they can also be modelled by setting the 

corresponding field on the fan’s properties panel. 
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Display settings for input data 

Aerodynamic resistances of airways and bulkheads are the input data to simulate ventilation. These 

values can be viewed on the property panels of the corresponding objects. 

 

 

Besides, the same data can be displayed as indicators by the menu Display-> Ventilation -> Input 

Data -> Airways: Indicators -> Resistances or Display -> Ventilation -> Input Data -> Equipment: 

Indicators -> Resistances of bulkheads. 

 

It may also be useful to mark the airways’ end nodes, which are connected with the atmosphere 

(Display -> Ventilation -> Input Data -> Airways’ End Nodes -> Connection with the atmosphere). 
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Finally, the user can check the directions of fan pressures (Display -> Ventilation -> Input Data -> 

Equipment -> Fan directions). 

 

Parameters of ventilation simulation 

 

Two methods can be used to calculate airflow: the enhanced Cross’s algorithm or the classic Cross's 

algorithm. They are based on the same principle: in an airway network the application selects a set 

of circuits, in each of which a fan’s pressure and a pressure drop due to aerodynamic resistance of 

the airways and bulkheads are iteratively made equal by air quantity adjustments. The enhanced 

Cross’s algorithm is the main one, since pressure drops are adjusted in all circuits simultaneously in 

that case, thus leading to quicker convergence. As for the classic Cross's algorithm, it adjusts 

pressure drops in one circuit per iteration, that is why it converges very slowly for large networks. 
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The calculation of airflow is considered to be successful, when the difference between fan pressures 

and pressure drops due to aerodynamic resistance is less than the value specified in the options 

("Max error" field) in all circuits. For the calculation to be successful, the number of iterations must 

also be limited by a certain value specified in the "Max iteration count" field. If the calculation should 

be done for some part of the schema only, then the required part of the schema can be placed on a 

separate view area or be marked as a separate layer, then made the only visible part and then the 

"Use visible airways only" option should be used. 

Besides, there may be a situation, when the aerodynamic resistance of some bulkhead categories 

should be ignored. For example, if the aerodynamic resistances of airways were defined by the data 

from a ventilation survey, then resistances of all bulkheads inside the airways were counted as the 

aerodynamic resistances of the airways themselves. However, the bulkheads’ locations should be 

marked by placing the corresponding objects on the airways thus adding to airway resistances, but 

such extra resistances should not be counted. In this case, the user can uncheck the "Use seals’ 

resistances" and "Use regulators’ resistances" options. 

Counting minor losses 

If aerodynamic resistances are defined by design data, then a user should also take into account the 

so-called minor losses together with the aerodynamic resistances of airways and bulkheads to get a 

more precise picture. These losses are related to some local peculiarities of airflow, which result in 

additional aerodynamic resistance connected with neither air friction by the airway walls, nor with 

the resistance of the bulkheads. For example, additional resistance may arise when the airway turns. 

However, the software application provides only one way to count such resistances, that is the 
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method calculating the resistance due to compression/expansion of airflow. It may especially be 

useful for the room and pillar mining method. 

In that case, the application calculates an additional pressure drop 𝑑𝑃+ for each output airway of an 

end node by the following formula. 

𝑑𝑃+ =
∑𝑄+ ∙ 𝑄𝑖 ∙ (𝑉+ − 𝑉𝑖)

2

2 ∙ (∑𝑄𝑖)2
∙ 𝜌 

𝑑𝑃+ - pressure drop due to the compression/expansion of the airflow 

𝑄+ - air quantity in the current airway 

𝑄𝑖 – air quantity in every 𝑖-th airway with the air flowing from the current end node (the formula 

considers only the output air quantities) 

𝑉+ - air velocity in the current airway 

𝑉𝑖 – air velocity in 𝑖-th airway 

𝜌 – air density 

Now let us consider an example of a simple ventilation network where air quantities were calculated 

with no minor losses. 

 

The airway in the middle is a wide room of 100 sq. m. cross-sectional area with the input and output 

of one narrow airway of 10 sq. m. cross-sectional area. And the air quantity in the airways is 37 cub. 

m. per sec. 

 

However, with local aerodynamic resistances the quantity decreases to 24 cub. m. per sec. Thus, to 

obtain a precise picture the user must consider local resistances in calculations based on design data 

when cross-sectional areas are greatly different. 
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Counting natural ventilation 

While moving through airways the air changes its temperature due to, for example, heat exchange 

with rock strata surrounding the airways. As a result, changes of elevation cause additional pressure, 

as the weights of air columns vary due to density differences. Here so-called natural ventilation effect 

occurs. With the main fan functioning, this effect may be neglected, since its influence is typically 

less than the measurement error. However, natural ventilation should not be ignored when simulating 

the stop of a main fan. 

To calculate additional pressure 𝑃𝑤𝑒𝑖𝑔ℎ𝑡 connected with an air weight for each airway the following 

formula is applied. 

𝑃𝑤𝑒𝑖𝑔ℎ𝑡 = 𝑔 ∙ (𝐻𝑓𝑟𝑜𝑚 − 𝐻𝑡𝑜) ∙ 𝜌0 ∙
𝑇0 + 273.15

𝑇𝑓𝑟𝑜𝑚 + 𝑇𝑡𝑜

2 + 273.15

 

𝑃𝑤𝑒𝑖𝑔ℎ𝑡 – pressure from the air weight in the airway 

𝑔 – gravity acceleration 

𝐻𝑡𝑜 – elevation of the airway's “to” node  

𝐻𝑓𝑟𝑜𝑚 – elevation of the airway's “from” node 

𝜌0 – air density at the temperature 𝑇0 

𝑇0 – air temperature determined by the air density 

𝑇𝑡𝑜 – air temperature at the airway's “to” node 

𝑇𝑓𝑟𝑜𝑚 – air temperature at the airway's “from” node 

Sample air density at a known temperature is set in the options (Options -> Ventilation 2 -> 

Calculation Parameters). 
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In this case, the difference of pressures 𝑃𝑤𝑒𝑖𝑔ℎ𝑡 at airway junctions will simulate the natural 

ventilation effect. However, to achieve this a user should define elevations and air temperatures in all 

airway's nodes. Let us consider the following example. 

 

A mine consists of two vertical shafts of 400 meters in length, which are joined by the only airway of 

15 km long. The intake air temperature is 20 degrees Celsius, then autocompression heats it up to 

22 degrees, and then the rock stratum heats it up to 27 degrees, and finally when the air goes up, it 

cools to 25 degrees. As a result, the weights of air columns in the shafts are different, and when the 

cold air in the left shaft squeezes the warm air in the right one, the natural ventilation effect occurs. 

If a user starts ventilation simulation for this schema and checks the "Use natural ventilation 

pressures" option, then even without fans there are non-zero air quantities directed from the cold air 

area to the warm air area. 

Simulating air ducts 

If some air is conducted through ducts, then they can be represented as airways on the schema, 

which are located on a separate layer above usual airways. For instance, the ventilation of a blind 

heading by an auxiliary fan is simulated on the schema below. 
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Evaluating calculation results 

Display settings 

It is important to interpret the obtained results appropriately after a ventilation simulation has been 

completed. First of all, a user should identify the directions of air quantities. By just enabling the 

display of air quantities (Display -> Ventilation -> Output Data -> Airways: Indicators -> Air quantities) 

the directions of airflows are still not clear. 

 

 In this case, a user may highlight the directions of the airways themselves (Display-> Common -> 

Airways -> Airways -> Directions) to be able to interpret positive or negative quantity values. 

 

However, displaying airflow directions is the most convenient method to evaluate the simulation 

results (Display -> Ventilation -> Output Data -> Airways -> Airflow directions). Here the quantities 

are always positive. 

 

The size of airflow arrows is specified on the options form. 
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Besides, it is important to understand what happens with the fan’s pressure, when air flows through 

airways. For this purpose there are two modes to display pressure drops: in airways (Display -> 

Ventilation -> Output Data -> Airways: Indicators -> Pressure Drops) and on bulkheads (Display -> 

Ventilation -> Output Data -> Equipment: Indicators -> Pressure drops on bulkheads). 

 

Sometimes a user should know absolute values of pressure at particular points on the schema rather 

than pressure drops. For example, it is especially important when a user needs to estimate a possible 

pressure drop, if a new airway is constructed between the points in question. In these cases, the 

application provides a mode to display absolute air pressures in airway's nodes (Display -> 

Ventilation -> Output Data -> Airways' End Nodes: Indicators -> Pressures). The nodes connected 

with the atmosphere are considered to have zero absolute pressures. If it is an intake fan, then airway 

nodes have positive pressures, otherwise, they have negative ones. 
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Additionally, gradient fill can be applied to visualize the same data (Display -> Ventilation -> Output 

Data -> Airways -> Pressure drops distribution and Display -> Ventilation -> Output Data -> Airways 

-> Pressure distribution). In the first case, airways with largest pressure drops are colored with red, 

while in the second case the same applies to the airways with largest absolute pressures. 

 

 

Measurements on the schema 

Some values can be calculated not for one airway, but for a sequence of airways on the schema. First, 

a user can measure distances. For this purpose, there is the Measure Distance command on the 

Schema ribbon tab. 

 

After using this button, a user should select a path on the schema by clicking on the airways that 

belong to the path. The right mouse button is used to cancel adding the last airway. As a result the 

path will be highlighted and its total length displayed. 
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The same way a user can measure a pressure drop or a power input along a selected path by the 

corresponding commands on the Ventilation ribbon tab. 

 

Besides, a user can create a pressure chart and export it to Excel. 

 

Identifying airflow types 

Another thing to check after a ventilation simulation is completed is the type of airflow in each airway, 

that is whether the air is fresh there or not. By default, the air in each airway is considered fresh and 

is displayed using red arrows. If it is not so, a user should mark the places on the schema where the 

air becomes polluted. It can be done by creating a mine section on the mine sections panel and 

specifying that it pollutes the passing airflow. 
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In that case, the air in the airways connected with that mine section will be considered used. 

Let us examine the following schema. Two workplaces are marked with blue and green. 

 

There, each airway has fresh air. However, if both workplaces are marked as polluting the passing air, 

then the airflow types will be as follows. 

 

The type of airflow on the exhaust airway is marked as used because when fresh air mixes with used 

air the result air is considered used. However, sometimes this is not so. For instance, when a 

ventilation schema has recirculation inside, fresh air mixes with the used air returning from 

recirculation but the result air can still be used, so it is technically fresh. In that case, a user should 

specify that air in certain airways is always fresh (on the Ventilation tab of the airway property panel). 
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Let us examine another schema where a workplace in the third airway is ventilated using 

recirculation. 

 

There, the airflow in the second airway is marked as used. In order to change that a user can specify 

that in the fifth airway the air should always be fresh. 

 

Checking fan operating modes 

A user must also check fan operating modes. For this purpose, the panel of fan properties displays 

the current air quantity of the selected fan as well as its current pressure and power. It also shows 

the fan's efficiency calculated by the following formula. 

𝜂 =
𝑄 ∙ 𝐻(𝑄)

𝑊(𝑄)
∙ 100 

𝜂 – fan's efficiency in percentage 

𝑄 – air quantity 

𝐻(𝑄) – fan pressure at the current air quantity 

𝑊(𝑄) – consumed electrical power at the current air quantity 
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It should be noted that the air quantity in the airway ("Q airway") and air quantity of the fan ("Q fan") 

are displayed separately, since they can be different for an ejector. 

The same parameters can be displayed with the corresponding indicators (Display -> Ventilation -> 

Output Data -> Equipment: Indicators -> Fan Pressures, Power of fans, Efficiency of fans). 

 

Besides, it is important to check whether the fan works in a permissible mode. For this purpose, the 

fan's duty point is displayed on the pressure and power curves for the selected blade angle (the 

current curves are highlighted with a blue color).  
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If the air quantity is within the legal bounds specified in the fan’s template, then the duty point 

becomes blue. Otherwise, the duty point is red, which means that the fan operates in stall or it 

functions on impermissibly large air quantity. 

   

To check the fan operating mode more quickly, a user can enable the highlighting of fans working in 

impermissible modes (Display -> Ventilation -> Output Data -> Equipment -> Not properly working 

fans). 

 

Besides, the pressure and power curves for the selected fan can be opened in a separate large window 

by clicking the Show Details button. 

 

In this case, a user can monitor the fan operating mode without any need to open the property panel. 
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Checking air velocities 

Together with air quantities a user must check air velocities in airways, because the safety 

regulations set certain limits for the maximum air velocity of different airway types. These limits can 

be specified both for some particular airways by the property panel or for all airways of the same type 

in the airway types editor. 

 

 

The sample values of maximum velocities are given in the dictionary which opens by clicking the 

button near the field. 

 

With no need to check the maximum air velocity this field should remain empty. 

The calculated air velocity in the selected airway can be found on the panel of airway properties. 
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Where the air velocity 𝑉 is calculated by the following formula. 

𝑉 =
𝑄

𝑆
 

𝑄 – air quantity in the airway 

𝑆 – airway cross-sectional area 

If a user wants to check the permissibility of air velocities in all airways on the schema at once, then 

they should use the corresponding indicator (Display -> Ventilation -> Output Data -> Airways: 

Indicators -> Air velocities). Besides, to make the search of airways with air velocities exceeding the 

limits easier the application provides a special mode to highlight such airways (Display –> Output 

Data -> Airways -> Exceeding max air velocity). 

 

Together with the limits on the maximum velocity the safety regulations also set restrictions on the 

minimum velocity in a ventilated airway. The minimum legal air velocity 𝑉𝑚𝑖𝑛 is calculated by the 

following formula. 

𝑉𝑚𝑖𝑛 = 0.1 ∙
𝑃

𝑆
 

𝑃– perimeter of the airway cross-section 

𝑆– airway cross-sectional area 

A user can visualize minimum air velocities on the schema by the corresponding indicator (Display -

> Ventilation -> Input Data -> Airways: Indicators -> Min legal air velocity). Besides, to check whether 

the current air velocities exceed the bounds, a user can highlight those airways that are considered 

to be ventilated (Display -> Ventilation -> Output Data -> Airways -> Ventilated airways). 
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To compare the airflow velocities visually, a user should use the air velocity fill (Display -> Ventilation 

-> Output Data -> Airways -> Air velocity distribution). In this case, airways with a high air velocity 

will be red, while airways with a low velocity - blue. 

 

Building a mine section tree 

One of the purposes behind the design of mine ventilation is to supply workplaces with appropriate 

quantities of air with minimum leakage. However, the simulation of ventilation provides a user with 

only individual air quantities in airways. Therefore, it may be quite difficult to check whether the 

overall quantity of air is enough, when the air is supplied through several airways. In this case, it is 

more appropriate to build a mine section tree and check the intake air quantity there. This can be 

done on Mine Sections tab of Side Bar. 

 

To create a new mine section a user should click the Add Section button thus creating a child for the 

selected tree element. If no mine section is selected, then a new section is placed at the top. If later 
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the tree structure is to be redesigned, it can be done by dragging and dropping the tree elements. If a 

name of a mine section needs to be changed, it can be edited in a special form that is opened by 

double-clicking the section. 

 

Each section is connected with a particular set of airways on the schema. A user can use Attach 

Selected Airways and Detach Selected Airways commands in the context menu of the corresponding 

mine section to change the list of mine section’s airways. After that, the airways of a mine section 

can be highlighted on the schema by hovering the mouse over the tree element. 

 

However, to simplify the identification of the airways attached to mine sections it is advisable to 

enable the display of mine sections’ colors on the schema (Display -> Common -> Airways -> Airways 

-> Mine section's color on borders/Mine section's color inside). 

Besides, a user can attach the selected airway to a mine section on Mine Sections tab of the airway 

properties panel. 
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Once the mine section tree is ready, it can display different indicators. For example, a user can add 

an indicator that shows an intake air quantity for each mine section. To do this, the Display menu 

should be applied. Then in the menu, a user can select which of the indicators should be displayed as 

well as enable other visualization settings, such as displaying mine section colors inside the tree. 

 

An intake air quantity is calculated as a sum of air quantities in the airways which are related to the 

mine section and have the airflows directed inside this section. Leakages are measured as a 

difference between the intake air quantity of a container mine section and a sum of intake air 

quantities of its subsections. However, the leakage calculation sometimes is to be adjusted, as some 

workplaces may be ventilated in sequence, while in others the air may recirculate. That is why 𝑄𝑙𝑒𝑎𝑘𝑠 

is generally described by the following formula. 

𝑄𝑙𝑒𝑎𝑘𝑠 = 𝑄𝑝𝑎𝑟𝑒𝑛𝑡 − ∑𝑄𝑐ℎ𝑖𝑙𝑑
𝑖 ∙ (1 − (𝐾𝑟𝑒𝑐𝑖𝑟𝑐𝑢𝑙𝑎𝑡𝑖𝑜𝑛

𝑖 + 𝐾𝑢𝑠𝑒𝑑
𝑖 ))

𝑖

 



38 

𝑄𝑙𝑒𝑎𝑘𝑠 – air quantity of leakages in the parent mine section 

𝑄parent – intake air quantity of the parent mine section 

𝑄𝑐ℎ𝑖𝑙𝑑
𝑖  – intake air quantity of the i-th child mine section 

𝐾𝑟𝑒𝑐𝑖𝑟𝑐𝑢𝑙𝑎𝑡𝑖𝑜𝑛
𝑖  – share (from 0 to 1) of the intake air quantity of the i-th mine section supplied due to 

recirculation 

𝐾𝑢𝑠𝑒𝑑
𝑖  – share (from 0 to 1) of intake the air quantity of the i-th mine section supplied from other 

sections in the same parent 

Let us consider a simple example of successive ventilation of two mine sections. 

 

 

Here the air entering the second workplace is considered to be used in the first section (that is why 

𝐾𝑢𝑠𝑒𝑑
2 = 1), which excludes the intake air quantity of the second section from the leakage 

calculation. 

Now let the part of the air in the first workplace return back via recirculation. 
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In this case, 𝐾𝑟𝑒𝑐𝑖𝑟𝑐𝑢𝑙𝑎𝑡𝑖𝑜𝑛 in the first section is 0.20 meaning that 4 out of 20 air units return back 

to the first section (not 5, as 1 unit leaks through the A - B airway below). As a result, the air quantity 

of A - B airway consists of 1 air unit from the first workplace leaving only 4 units for the overall 

leakage. 

Actually, the ventilation schema may be even more complicated. There can be several recirculation 

circuits, and fresh intake air can mix with used air. In these cases, the automatic leakage calculation 

is very helpful. 

Besides, together with the leakage quantities calculation the so-called leakage factor 𝐾𝑙𝑒𝑎𝑘𝑠 can be 

found. 

𝐾𝑙𝑒𝑎𝑘𝑠 =
𝑄𝑝𝑎𝑟𝑒𝑛𝑡

𝑄𝑝𝑎𝑟𝑒𝑛𝑡 − 𝑄𝑙𝑒𝑎𝑘𝑠
 

𝑄𝑝𝑎𝑟𝑒𝑛𝑡 – intake air quantity in the mine section 

𝑄𝑙𝑒𝑎𝑘𝑠 – air quantity of leakages in the mine section 

Once leakage factors are calculated for all mine sections based on the data from a ventilation survey, 

this factors can reasonably be used to calculate minimum air quantities even for other ventilation 

schemas with the same airway topology. 

 

As to the values of required airflows, they can be specified in the properties of mine sections. In that 

case, if the calculated input air quantity becomes lower than the required one, the latter value is 

displayed in red. 
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To simplify the preparation of design documentation the current mine section tree with all indicators 

can be exported into Excel using the Report command and by selecting the Mine section tree with 

indicators report type. 

 

Checking airflow stability 

The reliability of calculated air quantities is one of the issues arisen in design process. The point is 

that the airway aerodynamic resistance identification is prone to error. However, some air quantities 

do not practically depend on the accuracy of aerodynamic resistance measurements due to the 

topology, while air quantities in other airways may differ greatly, up to changes in airflow direction, 

due to the aerodynamic resistances of neighboring airways. For example, air quantities in cross-cuts 

joining a series of parallel airways may change directions depending on the pressure correlations in 

the junctions, with the quantity value being very small and able to reverse even at small variations of 

resistance in one of the airways. In this case, a user must not rely on the values and the directions of 

such quantities. As for the air quantities, for instance, in air shafts, the deviations in aerodynamic 

resistance of a few airways do not affect the value and the direction of their quantities at all. 
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There is an algorithm to check airflow stability in order to separate the airways with topology-

independent quantities from the airways with the quantities determined by a limited number of 

aerodynamic resistances of their neighbors. 

 

The algorithm performs a series of successive ventilation simulations with random changes in 

aerodynamic resistance of every airway by ±33% per iteration. Then for every airway, an average 

value of air quantity is calculated, and the ratio of this value to the current air quantity in the airway 

is considered the air quantity deviation. For the airways with random changes in aerodynamic 

resistances of their neighbors compensating each other air quantity deviations will be less than 30-

50%. The air quantities with deviations exceeding 100% cannot be trusted. 

 

The calculated value of the quantity deviation in the selected airway is shown on its property panel. 

There is also an option to enable the display of the corresponding indicator on the schema (Display -

> Ventilation -> Output Data -> Airways: Indicators -> Air quantities’ variations). To visualize airways 

with large airflow deviations a user should enable the highlighting of quantity deviations distribution 

(Display -> Ventilation -> Output Data -> Airways -> Airflow deviation distribution). 

 

For example, the quantity deviation in the central cross-cut on the schema above is 579 %, thus the 

corresponding airway is red colored. This resulted from the fact that the air quantity in the cross-cut 

is close to zero due to the general topology of the network, and this quantity is significantly depended 



42 

on the ratio of aerodynamic resistances of the neighboring airways, that is why a user must not rely 

on the calculated air quantity in this airway. 

However, even more important is to be sure in air quantities directions. That is why when checking 

quantity deviations the so-called ‘guaranteed’ quantities are calculated, that is, the quantities that 

deviated most in reverse direction due to fluctuations in neighboring airways resistances. A user can 

display ‘guaranteed’ quantities by the Display -> Ventilation -> Output Data -> Airways: Indicators –

> Guaranteed air quantities mode or by enabling the Display -> Ventilation -> Output Data -> Airways: 

Indicators –> Guaranteed quantities distribution fill. If all air quantities directions coincide with 

airway directions, then a negative ‘guaranteed’ quantity means that a user should not trust the 

direction of the calculated air quantity.  

Checking for recirculation 

The absence (or, in some cases, close control) of recirculation circuits is one of the important 

conditions to provide safe ventilation in the mine. A recirculation circuit is a sequence of airways 

where polluted exhaust air mixes with fresh intake air. For a large network, it is very difficult to find 

such circuits. Specifically for these cases, there is an algorithm to find and to highlight recirculation 

circuits (the Check For Recirculation command on the Ventilation ribbon tab). 

 

After clicking this button a message with the overall number of found recirculation circuits will pop 

up, and if there is at least one circuit found, the highlighting mode will be enabled (Display –> 

Ventilation -> Output Data -> Airways -> Recirculation pathways). 
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Calculating costs 

It is useful to know the distribution of the fan's power, that is, what share of the power is spent on the 

ventilation of each airway. To calculate the power 𝑊 applied to ventilate an airway the following 

formula is used. 

𝑊 = 𝑔 ∙ 𝑅𝑓𝑢𝑙𝑙 ∙ 𝑄3 

𝑔 – gravity acceleration 

𝑅𝑓𝑢𝑙𝑙 – overall aerodynamic resistance of the airway (together with bulkhead resistances) 

𝑄 – air quantity in the airway 

The power cost of ventilating the selected airway is displayed on the property panel. 

 

Besides, power costs can be visualized on the schema by enabling the corresponding indicator 

(Display -> Ventilation -> Costs -> Airways: Indicators -> Power costs per unit length) and fill (Display 

-> Ventilation -> Costs -> Airways -> Power cost per unit length distribution), resulting in coloring 

airways with high power cost of ventilation in red.  

 

If the cost of electricity is known, then the cost of ventilation can easily be transferred into money 

equivalent. The cost of one kilowatt-hour and the currency are set in the options (Options -> 

Ventilation 2 -> Cost of Ventilation). 
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Then the same information can be presented as financial costs on ventilation during a year (Display 

-> Ventilation -> Costs -> Airways: Indicators –> Financial costs per year and unit length and Display 

-> Ventilation -> Costs -> Airways -> Financial cost per unit length distribution). 

 

 

Aligning airway directions with air quantities 

After the simulation of ventilation is complete it may be useful to align airway directions with the 

direction of air quantities. In this case, all quantities become positive values. Besides, some 

algorithms may rely on airways being directed along the airflow. 
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Saving calculated quantities as measured 

The data is very often handled in the following sequence. First, the measurements from a ventilation 

survey are processed, based on which measured air quantities and pressure drops in airways are set. 

This helps to calculate overall aerodynamic resistances of airways. As a result, when the fans are 

placed on the schema, it is possible to simulate ventilation and calculate air quantities. However, 

sometimes the obtained calculated quantities should be saved again as measured ones so, as if they 

are based on the results of a ventilation survey. It might be applicable in heat simulation. 

 

Exporting fans to Excel 

The chart with fan’s power curves can be exported to Excel, which is convenient for creating reports. 

In order to do that, a user should launch the Export to Excel command on the properties panel of the 

fan. 
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As a result, all power curves will be exported. Moreover, the duty point will displayed as well as the 

lines of fan’s efficiency. 
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Exporting airway data to Excel 

Having done all calculations a user should finalize design solutions in ventilation. This can be done 

by creating appropriate reports with the solutions described in written form and illustrated with 

necessary tables and charts. As for the tables, they usually contain different types of airway 

ventilation parameters. Such data can be easily copied into a worksheet in Excel by the special button 

on the Ventilation ribbon tab. 

 

Clicking the button opens a dialog window where the user is offered to select the parameters to be 

exported to Excel. As there are a lot of parameters shown, it is better to clear the selection from all 

the elements by unchecking the checkbox above, and only then start checking the needed parameters 

in the list. Besides, this dialog window provides a user with an option to narrow the exported set of 

airways. For example, a user can export only visible airways or only the airways selected on the 

schema at the moment. It may also be convenient to choose a standard set of parameters rather than 

select individual ones. 

 

Saving air quantities 

Ventilation design means selecting between many possible options. In that case, a user should have 

a tool to compare such options quickly. The list of saved ventilation modes on the Ventilation ribbon 

tab is a way to do so. The Save Airflow command adds the current calculated air quantities to the list 

allowing a user to specify a corresponding name. 
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Later saved air quantities can be restored without performing a calculation by simply clicking on an 

element of that list. 

Optimal control 

Selection of the controlled objects 

The installation of regulators is one of the ways to control air distribution in a mine. In this case, each 

regulator lets only a share of airflow to pass depending on the orifice area, while the rest part of the 

airflow goes in other mine sections. However, if there are more than two regulators, then it may be 

difficult to adjust the areas of the corresponding orifices, as a change in the area of one orifice results 

in air redistribution in the whole mine. Besides, the task becomes even more challenging, as a user 

should select an optimal configuration so, as to provide the required quantity of air to all consumers 

with a minimum pressure of the main fan. 

The algorithm of optimal control automates the solution of the task described above. It is necessary 

to select regulators participating in the control (that is, regulators the areas of which orifices should 

be optimized). If a user selects only a few regulators to be adjusted, this decreases the time of 

calculation significantly. This is especially so when the orifice area of some regulators is obvious 

beforehand (for example, the regulators must always be completely closed or open). A minimum air 

quantity is also specified for each regulator. All participating regulators can be conveniently 

highlighted on the schema (Display -> Ventilation -> Optimal Control -> Equipment-> Participation). 
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In addition to this, fans the pressure of which are minimized should also be marked as participating 

in optimal control. It is necessary to specify a maximum pressure for each fan, with this value being 

the threshold of optimization. 

 

After that, clicking the Minimize Fan Pressure button on the Ventilation tab will launch the algorithm 

of optimal control. 

 

Optimal control parameters 

Optimal control algorithm works iteratively selecting such fans’ pressures, as to satisfy all 

requirements in air quantities by adjusting orifice areas of regulators. The algorithm starts with 

maximum fan pressures, which are set in fan properties, and then it continues to lower them. If further 

decrease of pressure results in the impossibility to achieve required quantities by adjusting the 

regulators, then the pressure and regulators configuration of the preceding iteration are considered 

optimal. 
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The maximum number of iterations for adjusting regulators is configured on the parameters form, as 

well as the largest possible resistance of regulator and the method of setting minimum air quantities. 

By default, minimum air quantities are set in the properties of regulators, but there is an option to 

take those quantities from the mine sections the regulators belong to. In that case, the algorithm tries 

to satisfy not an air quantity in a single airway, but a total input air quantity of mine section. A mine 

section minimum quantity can be either set manually, or calculated if there is special module for that 

installed. 

Displaying results 

Let us look at the following example of airway network where there are four regulators. Minimum air 

quantities on the regulators are displayed as indicators (Display-> Ventilation -> Optimal Control–> 

Min quantities for bulkheads). Besides, initially all orifices are completely open, that is why all 

regulators have zero aerodynamic resistance (Display -> Ventilation -> Input Data -> Equipment: 

Indicators -> Resistances of bulkheads). With this configuration of the regulators and fan's pressure 

of 50 Pa the air distribution is as follows. 

 

Thus, air quantities should be reduced. After the algorithm of optimal control is applied, the air 

distribution will change. 
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Air quantities in airways will become equal to the required ones and fan pressures will be lowered. 

Besides, each regulator will receive an optimal aerodynamic resistance. 

Processing of ventilation survey data 

Necessity for automatization 

Aerodynamic resistances of airways 𝑅 is an important component in a ventilation model of a mine. It 

is impossible to predict air quantities without such values, when these or those design parameters of 

a mine, such as pressure of the main fan or a bulkhead location, are changed. That is why it is 

important to measure the values 𝑅 regularly during ventilation surveys. In the course of these surveys 

air quantities 𝑄 and corrected air pressures 𝑃 (corrected pressure differs from absolute pressure, 

with the first leveling the atmospheric pressure fluctuations on the surface) are measured at 

particular points of the mine. In this case, aerodynamic resistance 𝑅 is described by the following 

formula. 

𝑅 =
∆𝑃

𝑄2
 

∆𝑃 – pressure drop in the airway 

It is important to note that it is difficult to measure 𝑄 and 𝑃 in all airway junctions, since a mine may 

be several tens of kilometers in length. This inevitably results in the fact, that the quantities 𝑄 and 

corrected pressures 𝑃 are measured only for a limited number of airways. As aerodynamic resistance 

𝑅 should be calculated for all airways, then the unmeasured 𝑄 and 𝑃 need be somehow defined. This 

used to be done by "estimating" the unknown air quantities and pressures on the paper schema of 

the mine, ensuring that new values of quantities and pressures do not contradict the measured ones, 
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and, overall, the ventilation model is justified. However, with this approach the precision of airway 

aerodynamic resistances greatly depended on the qualification and the experience of the user 

defining the unknown 𝑄 and 𝑃. Besides, this process was very time-consuming. Therefore, a number 

of tools aimed at, to some extent, automating the processing of ventilation survey data were 

developed in the application. 

Setting measured air quantities 

Setting the known quantities is the first step to calculate the unknown ones. The objects on airways 

called measuring stations are intended to store such known quantities. This helps to evaluate 

visually, where the known quantities are defined. The value of a quantity is entered on the property 

panel of a measuring station. 
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Then the known quantities can be visualized by the corresponding indicator (Display -> Ventilation -

> Input data -> Equipment: Indicators -> Air quantities at stations). Along with that, only those 

measurements with the Use in calculation flag checked are used. 

 

This allows a user to place all measurements on the schema, but use only a part of them for 

calculations, while the other part remains for validation. 

 

However, if all quantities are known, then the measured quantities can be set right in the properties 

of airways. In order to do that a user should select the type of aerodynamic resistance equal to 

"Defined by survey". 

 

Distribution of air quantities 

It is very important to mark all nodes connected with the atmosphere for the quantity distribution 

algorithm to work properly. In this case, these nodes are believed to let in any necessary quantity of 

air. Let us apply the algorithm on the following schema. 

 

This schema has a known intake air quantity and two end nodes connected with the atmosphere. The 

corresponding button on the Ventilation ribbon tab launches the algorithm of quantity distribution. 
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As a result, the quantities are distributed as follows (Display –> Ventilation -> Input Data -> Airways: 

Indicators -> Measured air quantities). 

 

For the intake airway the air quantity is defined as equal to the quantity in the measuring station, 

while for all other airways quantities are set based on the estimated airway aerodynamic resistances. 

Estimated resistance of an airway depends on its length, the cross-sectional area and the resistance 

of bulkheads installed there. For example, a user may specify that a seal blocking the airflow is placed 

in the airway below. In this case, the algorithm gives quite a different model of air distribution. 

 

Besides, if wrong evaluation of airway resistances results in improbable quantities, then a user can 

assist the algorithm by placing additional measuring stations on the schema. For instance, according 

to a ventilation survey the air quantity in the upper airway should be 15 cub. m per sec, while with the 

current air distribution it is only 12.3 cub. m per sec. Then the quantity in the upper airway can be 

defined explicitly by inserting a measuring station there. 
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However, the case may be that the quantities measured during a ventilation survey can be relied on 

to a certain extent because of different reasons. Therefore, it is advisable to define an excessive 

number of known quantities, thus letting the algorithm to coordinate them. This means that the 

algorithm adjusts the known quantities so, that intake and return quantities for all airway subnets 

limited with measuring stations are balanced. For example, for the above-mentioned network a user 

can additionally specify that the air quantity in the return airflow is 40 cub. m. per sec, which 

contradicts the known quantity of the intake airflow. The algorithm, however, resolves all the 

contradictions by choosing an average value of the known quantities in the intake and return airflows, 

which is equal to 35 cub. m per sec. 

 

It is important to remember that the algorithm works iteratively, that is why in case of some 

inaccuracies in its work the number of iterations should be increased both at the stage of the 

distribution of unknown quantities and at the stage of the adjustment of known quantities. 

 

Sometimes, however, certain quantities are measured very accurately in comparison with other ones. 

It is especially so, when some measurements show large air quantities, which can be trusted, while 

other measurements are conducted in those places where the air flows very slowly, which means that 

such measurements cannot be trusted. In this case, a user can mark the quantities that should not 

be adjusted. This is determined by the option on the property panel of measuring station. 
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For example, a user may specify that the quantity of the intake airflow is measured precisely. In this 

case, it will be not adjusted. 

 

Checking distributed quantities 

The algorithm of airflow distribution is a half-computerized algorithm, which makes the user's work 

easier, but still does not automate the task entirely. This means that the calculated quantities are just 

estimations, which an expert in ventilation can accept as reliable or provide the algorithm with some 

additional information, such as new measurements of quantities or the placement of bulkheads on 

airways. The algorithm guarantees that the obtained result is the best one among other alternatives, 

which can be derived from the data, and ensures the simplest ratios, such as balancing the intake 

and return airflows at the airways' nodes. However, if the unknown quantities are distributed 

manually, then there is a mechanism of checking the airflow balance in each node (Display -> 

Ventilation -> Input Data -> End Nodes -> Non-zero airflow balances). 

 

Here the nodes with non-zero balance are highlighted with red, and the corresponding value is 

displayed above. The nodes connected with the atmosphere are also checked. In the latter case, it is 

tested that the air quantity taken from the atmosphere equals the return air quantity.  

Besides, there is a special mode of highlighting those measuring stations with the quantities not 

corresponding to the quantities in the airways by more than 10 percent (Display -> Ventilation -> 

Input Data -> Equipment -> Stations with wrong air quantities). This helps to monitor those stations 

with the known quantities being significantly changed during the distribution process. 
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As for the other checks, in this case all highlighting modes related to the ventilation simulation are 

applicable, because the algorithm of quantity distribution sets both the ventilation survey quantities 

as well as the calculated ones. For instance, it is of special importance to check the presence of 

recirculation circuits. 

One more way to ensure the correctness of ventilation survey data is to construct a ventilation model 

on the same network (after the pressure distribution is finished and when the aerodynamic 

resistances of all airways are known). In this case, a user can check that the directions of all quantities 

defined by measurements coincide with the directions of the calculated ones. There is a special 

highlighting mode to simplify that check: Display -> Ventilation -> Output Data -> Airways -> 

Uncoordinated air quantities. A user can configure exactly when such quantities are considered 

uncoordinated on the Options form. 

 

Setting air pressures 

In contrast to air quantities, measured air pressures are set in the properties of airway nodes. 
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In the list of measurements a user enters data from a ventilation survey, if any, and in the Corrected 

pressure field there should be the value used for calculation of the aerodynamic resistances of 

neighboring airways. 

 

 

To display both types of pressure there are two indicators (Display -> Ventilation -> Input Data -> End 

Nodes: Indicators -> Measured pressure / Corrected pressure). Besides, there is an option to view 

pressure drops in airways rather than absolute pressures in the nodes (Display -> Ventilation -> Input 

Data -> Airways: Indicators -> Measured pressure drops). 
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Correcting measured pressures 

Measured air pressures cannot be used until they are corrected. For instance, these values should 

not include deviations due to unstable atmospheric pressure, different elevations, air temperatures 

or relative humidity. Otherwise, measured air pressure values will be incomparable. 

Deviations of atmospheric pressure are set by the Edit Atmosphere Pressure command on the 

Ventilation ribbon tab. 

 

 

In this window a user can specify the value of standard atmospheric pressure, as well as the 

corresponding elevation and air density. Then the list of measured atmosphere pressures is 

populated. This list can also be imported from a CSV file. The details of the operation are configured 

on a separate form. 
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When deviations of atmospheric pressure are specified, measured air pressures in end nodes can be 

corrected, not just entered. For that purpose, a user should select the “Corrected pressure” 

measurement type instead of “Air pressure”. 

 

In that case, the value of elevation, air temperature and relative humidity should also be set. 
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Corrected air pressured is calculated using the following formula. 

𝑃𝑐𝑜𝑟𝑟𝑒𝑐𝑡𝑒𝑑 = (𝑃𝑚 − 𝑃𝑎(𝑡)) +
𝜌𝑎 + 𝜌

2
∙ (𝐻 − 𝐻𝑎) 

𝑃𝑐𝑜𝑟𝑟𝑒𝑐𝑡𝑒𝑑 – corrected air pressure 

𝑃𝑚 – measured air pressure 

𝑃𝑎(𝑡) – atmospheric pressure at the t time 

𝜌𝑎  – user-defined air density for standard atmospheric pressure 

𝜌 – air density at the place of measurement 

𝐻𝑎 – user-defined elevation for standard atmospheric pressure 

𝐻 – elevation at the place of measurement 

Air density 𝜌 is calculated by the following formula. 

𝜌 =
0.0035 ∙ (𝑃𝑚 − 𝑃𝑎(𝑡) + 𝑃𝑠) ∙ 𝑔 − 0.00132 ∙

𝑅𝐻(479 + (11.52 + 1.62 ∙ 𝑇)2)
100

273.15 + 𝑇
 

𝑃𝑠 – user-defined standard atmospheric pressure 

𝑔 – acceleration of gravity 

𝑅𝐻 – relative humidity at the place of measurement 

𝑇 – air temperature at the place of measurement 

Distribution of air pressures 

Usually the air pressure can be measured only for a limited number of the network nodes, as in the 

case of air quantities. For the majority of nodes corrected pressures should be set manually to have, 

overall, a consistent ventilation model. In its turn, the algorithm of pressure distribution aims to 

automate this process by estimating unknown air pressures. Let us consider the following example. 
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Setting measured quantities in all airways is a necessary condition for the algorithm of pressure 

distribution to work correctly. This step can be done manually or with the help of the quantity 

distribution algorithm. In the network above measured quantities were set equal to 30 cub. m per s 

for all airways except the one containing a seal. Then the measured air pressures of 100 and 0 Pa 

were set in each node connected with the atmosphere (indicator 𝑃′). After that, the algorithm of 

pressure distribution was launched (Distribute Pressures button on the Ventilation ribbon tab). 

 

As a result, the corrected pressure was set in all nodes (indicator 𝑃). In the atmospheric nodes it 

became equal to the measured pressures, while in all other nodes the air pressure was estimated so, 

that it did not contradict the laws of physics. By default, the algorithm distributes pressure drops in 

correlation with aerodynamic resistances of the airways. A user, however, can disable this option and 

ensure that the resistances of airways must be considered equal to one another. 

 

That is, if on the above-mentioned schema a regulator with an adjustable orifice is installed in one of 

the airways, then with the Use resistances defined by design option enabled the algorithm distributes 

the air pressure in the nodes to have the highest pressure drop on this regulator. 
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For example, when a regulator is inserted in the corresponding airway, the pressure drop increases 

from 15 to 58 Pa. At the same time, the picture of pressure distribution can always be iteratively 

adjusted by entering new values of measured pressure on the schema. For instance, a ventilation 

survey can reveal that the pressure in the upper right node is 45 Pa, rather than 28 Pa estimated by 

the algorithm. In this case, a user can set a new value in this node, thus leading to changes in 

pressures of all nodes. 

 

Besides, it is important to limit the maximum possible design resistance of an airway (Max resistance 

parameter) to prevent the concentration of pressure drops on seals. Moreover, it is necessary to set 

the minimum air quantity (Minimum non-zero Q), which is the threshold for an airway not to 

participate in the algorithm of pressure distribution. This helps to set adequate values of pressure in 

those places with practically no airflow. 

Checking distributed pressures 

Pressure distribution can be done both manually and with the corresponding algorithm. In both cases, 

it is advisable to check the obtained result by enabling a special mode highlighting wrong pressure 

drops (Display -> Ventilation -> Input Data -> Airways -> Wrong measured pressure drops). A pressure 

drop in an airway is considered wrong, when the pressure drop is directed against the airflow in the 

airway. Let us consider the following example. 

 

In this network, all three airways have the measured quantity of 12 cub. m per sec specified. However, 

the pressure drop coincides with the quantity direction in the first and the third airways only. The 
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airway in the middle is highlighted in red, since the airflow is accompanied with an increase in 

pressure. 

Selecting design resistance 

When measured quantities are specified in all airways, and corrected air pressures are set in all nodes, 

then it becomes possible to calculate aerodynamic resistances of airways. To do this, in the panel of 

airway properties a user can just set that the aerodynamic resistance is defined based on ventilation 

survey data. Then the field with the measured air quantity becomes visible, as well as the field with 

the measured pressure drop calculated by the difference of the corrected pressures in the end nodes. 

 

However, this way of calculating airway resistance is not quite convenient. In this case, the 

aerodynamic resistance of airway includes the aerodynamic resistances of all bulkheads inside. The 

ventilation simulation requires a way of changing values of different design parameters such as 

cross-sectional areas of regulators’ orifices, which is difficult when the aerodynamic resistance of 

airway itself and all regulators inside is defined by the same value. To avoid this the application offers 

a special algorithm of selecting design parameters of airways (k-factors) and bulkheads (orifice areas 

/ air permeabilities) to obtain the required total aerodynamic resistances determined by the design 

data only. 

 

The corresponding button on the Ventilation ribbon tab works for all airways on the schema. However, 

this procedure can be applied to selected airways or bulkheads only. 
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The latter is handy, since selecting design airway resistances is important only for the airways that 

have regulators, that is why it might be senseless to select design resistance for all airways. 
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Heat 

Heat transfer with rock strata 

Principles 

The purpose behind ventilation design is both to comply with all necessary safety regulations and to 

provide required air quantities to consumers. The fact that the air temperature in an airway must be 

within the range of 2 and 27 degrees Celsius is one of these regulations. Very cold air in a mine can 

lead to icing, which is very dangerous, especially for ventilation shafts. As for the limit on maximum 

air temperature, this is connected with the necessity to maintain comfortable microclimate for the 

workers. However, ventilation design with all these limits may face certain difficulties. Together with 

all other factors, the air temperature is affected by the heat transfer with the surrounding rock strata. 

The problem is that it is difficult to say something precise about the heat distribution inside rock 

strata. In this case, there are two main methods to be used. The first method is applicable for the 

situation, when it is possible to carry out a temperature survey on site and identify temperature drops 

and air quantities in airways. Then the heat transfer coefficients can be calculated, which allow 

predicting temperature drops when air quantities change. The disadvantage of this method is that it 

requires measurements to be made, and cooling or heating of the rock strata surrounding airways is 

neglected. The second method simulates the heat transfer between air and rock strata in time. In this 

case, it is possible to evaluate the current heat distribution in rock strata right from the airway 

construction, and it becomes possible to develop air temperature forecast determined by temperature 

changes in rock strata. 

To simulate the heat transfer between the rock strata and the air in accordance with the second 

approach the application has an editor, which is opened with a special button on the Heat ribbon tab. 

 

This editor simulates heat transfer with the rock strata for only one airway. Heat transfer modeling 

for an airway network is explained later. 

First, a user should create a new model of heat distribution by clicking the corresponding button, and 

then assign a name for the model. 
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In such a model, heat transfer is simulated with a rock volume, which is limited by an imaginary 

cylinder with a vertical axis merging with the airway axis. The radius of this cylinder should be 

selected in such a way, as to guarantee that the rock temperature suffers negligibly small fluctuations 

at the chosen distance due to the heat transfer with the air inside the airway. 

 

Then the selected cylinder volume is divided into small cylinders along the airway direction according 

to the specified mesh count. 
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The rock stratum inside each small cylinder is divided into concentric rings of ∆𝑅𝑖 in width according 

to the specified number of radial sections. 

 

The width of the rings is chosen in such a way, as to have a ring of 0.6 mm in width near the airway's 

walls, while the width of other rings increases incrementally, thus adding up to the total radius of the 

cylinder 𝑅𝑗𝑎𝑐𝑘𝑒𝑡 minus the radius of the airway. Such a division guaranties that the model can reflect 

even the smallest air temperature deviations while preserving a minimum number of rings. 

 

Besides, heat is supposed to be transferred in the radial direction only in rock strata, while in the 

horizontal direction heat is transferred only by the airflow. Taking all these suggestions into account, 

the following equation connecting heat flow from the neighboring rings with the temperature changes 

in the current ring can be written for each concentric ring with a radial index 𝑖 (indexing from the 

airway's walls). 

𝑘𝑐𝑜𝑛𝑑𝑢𝑐𝑡𝑖𝑣𝑖𝑡𝑦 ∙ ∆𝑡 ∙ (𝑆𝑖 ∙
𝑇𝑖−1

𝑛 − 𝑇𝑖
𝑛

∆𝑅𝑖−1 + ∆𝑅𝑖

2

+ 𝑆𝑖+1 ∙
𝑇𝑖+1

𝑛 − 𝑇𝑖
𝑛

∆𝑅𝑖+1 + ∆𝑅𝑖

2

) = −𝑐𝑟𝑜𝑐𝑘 ∙ 𝜌𝑟𝑜𝑐𝑘 ∙ 𝑉𝑖 ∙ 𝑇𝑖
𝑛−1 

𝑘𝑐𝑜𝑛𝑑𝑢𝑐𝑡𝑖𝑣𝑖𝑡𝑦 – heat conductivity of rock strata 

∆𝑡 – time required for the air in the airway to pass through one longitudinal section with the current 

air quantity 

𝑅𝑗𝑎𝑐𝑘𝑒𝑡 

∆Ri 
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𝑇𝑖
𝑛 – unknown temperature of rock strata in the i-th ring at the n-th step of simulation 

𝑇𝑖−1
𝑛  – unknown temperature of rock strata in the (i – 1)-th ring at the n-th step of simulation 

𝑇𝑖+1
𝑛  – unknown temperature of rock strata in the (i + 1)-th ring at the n-th step of simulation 

𝑇𝑖
𝑛−1 – known temperature of rock strata in the i-th ring at the (n - 1)-th step of simulation 

𝑆𝑖 – contact area of the i-th ring with the (i - 1)-th ring 

𝑆𝑖+1 – contact area of the i-th ring with the (i + 1)-th ring 

∆𝑅𝑖 – width of the i-th ring 

𝑐𝑟𝑜𝑐𝑘 – specific heat capacity of the rock strata 

𝜌𝑟𝑜𝑐𝑘 – density of the rock strata 

𝑉𝑖 – volume of the i-th ring 

If the equation describes a ring bordering the virgin rock strata, then it should be written as follows. 

𝑘𝑐𝑜𝑛𝑑𝑢𝑐𝑡𝑖𝑣𝑖𝑡𝑦 ∙ ∆𝑡 ∙ (𝑆𝑖 ∙
𝑇𝑖−1

𝑛 − 𝑇𝑖
𝑛

∆𝑅𝑖−1 + ∆𝑅𝑖

2

− 𝑆𝑜𝑢𝑡𝑒𝑟 ∙
𝑇𝑖

𝑛

∆𝑅𝑖

2

) = −𝑐𝑟𝑜𝑐𝑘 ∙ 𝜌𝑟𝑜𝑐𝑘 ∙ 𝑉𝑖 ∙ 𝑇𝑖
𝑛−1 − 

− 𝑘𝑐𝑜𝑛𝑑𝑢𝑐𝑡𝑖𝑣𝑖𝑡𝑦 ∙ ∆𝑡 ∙ 𝑆𝑜𝑢𝑡𝑒𝑟 ∙
𝑇𝑜𝑢𝑡𝑒𝑟

∆𝑅𝑖

2

 

𝑇𝑜𝑢𝑡𝑒𝑟 – virgin rock temperature 

𝑆𝑜𝑢𝑡𝑒𝑟 – contact area of the outer ring with the surrounding rock strata 

If the equation describes a ring contacting the air in the airway, then it should be written as follows. 

𝑘𝑐𝑜𝑛𝑑𝑢𝑐𝑡𝑖𝑣𝑖𝑡𝑦 ∙ ∆𝑡 ∙ (𝑆0 ∙
−𝑇𝑖

𝑛

∆𝑅𝑖

2

+ 𝑆𝑖+1 ∙
𝑇𝑖+1

𝑛 − 𝑇𝑖
𝑛

∆𝑅𝑖+1 + ∆𝑅𝑖

2

) = −𝑐𝑟𝑜𝑐𝑘 ∙ 𝜌𝑟𝑜𝑐𝑘 ∙ 𝑉𝑖 ∙ 𝑇𝑖
𝑛−1 − 

−𝑘𝑒𝑚𝑖𝑠𝑠𝑖𝑜𝑛 ∙ 𝑇𝑎𝑖𝑟
𝑛−1 ∙ 𝑆0 ∙ ∆𝑡 

𝑇𝑎𝑖𝑟
𝑛−1 – known temperature of air in the previous iteration at the current longitudinal section 

𝑘𝑒𝑚𝑖𝑠𝑠𝑖𝑜𝑛 – heat transfer coefficient of the airway's walls 

𝑆0 – contact area of air with the airway's walls at the current longitudinal section 

Thus, with known temperatures of rock strata in the rings and air temperature in the previous iteration 

the above-mentioned equation system can be solved, and the temperatures of rock strata in the rings 

can be found for the next iteration, that is after ∆𝑡 time period. Then the air temperature can be 

adjusted as follows. 

𝑇𝑎𝑖𝑟
𝑛 =

𝜌𝑎𝑖𝑟 ∙ 𝑐𝑎𝑖𝑟 ∙ 𝑉𝑎𝑖𝑟 ∙ 𝑇𝑎𝑖𝑟
𝑛−1 + 𝑘𝑒𝑚𝑖𝑠𝑠𝑖𝑜𝑛 ∙ 𝑆0 ∙ ∆𝑡 ∙ 𝑇𝑤𝑎𝑙𝑙

𝑛

𝜌𝑎𝑖𝑟 ∙ 𝑐𝑎𝑖𝑟 ∙ 𝑉𝑎𝑖𝑟 + 𝑘𝑒𝑚𝑖𝑠𝑠𝑖𝑜𝑛 ∙ 𝑆0 ∙ ∆𝑡
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𝑇𝑎𝑖𝑟
𝑛  – unknown air temperature at the current longitudinal section in the n-th iteration 

𝑇𝑎𝑖𝑟
𝑛−1 – known air temperature at the current longitudinal section in the (n – 1)-th iteration 

𝜌𝑎𝑖𝑟 – air density 

𝑐𝑎𝑖𝑟 – specific heat capacity of air 

𝑉𝑎𝑖𝑟 – air volume at the current longitudinal section 

𝑇𝑤𝑎𝑙𝑙
𝑛  – temperature of the nearest ring of rock strata in the n-th iteration 

As a result, with the temperature of rock strata and air in all longitudinal sections having been 

recalculated the air temperature in these sections can be “relocated” one position towards the air 

direction, thus simulating the specified air quantity, provided ∆𝑡 is chosen for the air to travel exactly 

the length of one longitudinal section. 

Along with that, at the very start of the simulation the temperature of the rock strata is determined 

by the initial temperatures specified in the options, where it is possible to set the temperature of the 

virgin rock strata at the beginning and at the end of the airway. Thus, the initial temperature of the 

rock strata is interpolated between the specified values along the airway length. 

 

Autocompression 

Together with the heat exchange with the rock strata the temperature of the air inside an airway is 

influenced by the air heating due to autocompression. This is connected with the fact that when the 

air goes along an inclined airway, the air pressure changes resulting in changes in air temperature. If 

air gets down to the bottom of the mine, the air temperature increases, if air gets up, its temperature 

decreases. If the elevation delta between the initial and the end node of an airway is not large, then 

this effect can be neglected, although the situation is completely different when simulating heat 

exchange in shafts of several hundred meters in depth. In these cases, it is necessary to enable the 

simulation of autocompression when calculating the air temperature. 

 

Besides, a user should also specify the elevations of the initial and the end nodes of the airway. 
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Then the air temperature 𝑇𝑎𝑖𝑟 at each longitudinal section of the airway is additionally adjusted by 

the value calculated using the following formula. 

𝑇𝑎𝑖𝑟 = 𝑇𝑎𝑖𝑟 +
𝑔 ∙ ∆𝐻

𝑛 ∙ (𝑐𝑎𝑖𝑟 + 𝑅𝑎𝑖𝑟)
 

𝑔 – gravity acceleration 

∆𝐻 – elevation drop in the airway 

𝑛 – number of longitudinal sections in the airway 

𝑐𝑎𝑖𝑟 – specific heat capacity of air 

𝑅𝑎𝑖𝑟 – gas constant for air 

Ventilation modes 

Having defined parameters of the rock strata a user should populate a list of ventilation modes in the 

sequence these modes are applied. The purpose of this list is to simulate the history of airway 

ventilation from its construction inside the virgin rock strata. Thus, the current heat distribution inside 

the rock strata can be estimated, and its further development can be predicted. 

By default, a new model always has one ventilation mode, although more modes can be added to the 

list with the Add Ventilation Mode button. 

 

Each mode has its period, during which it is applied. 

 

Besides, the quantity and the temperature of the input air in the airway are specified for each 

ventilation mode. 
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This quantity is used to find the parameter ∆𝑡 when solving the heat balance equations for rock strata 

rings. The air temperature set in ventilation mode is the one, which is specified for the first 

longitudinal section when simulating the airflow. The heat transfer coefficient of the airway's walls is 

also entered, since its value may change because of the quantity. 

 

Besides, a user can also specify the air pressure at the beginning and the end of the airway. 

 

These values adjust the air density 𝜌 in each longitudinal section of the airway with the following 

formula. 

𝜌 =
𝑃

𝑅𝑎𝑖𝑟 ∙ (𝑇 + 273.15)
 

P – air pressure at the current section of the airway 

𝑅𝑎𝑖𝑟 – gas constant for air 

𝑇 – air temperature at the current section of the airway 

If the airway has only one section, then the pressure 𝑃 is calculated as follows. 

𝑃 =
𝑃𝑓𝑟𝑜𝑚 + 𝑃𝑡𝑜

2
 

𝑃𝑓𝑟𝑜𝑚 – air pressure at the initial node of the airway 

𝑃𝑡𝑜 – air pressure at the end node of the airway 

If there are many sections, then another formula is applied. 

𝑃 =
𝑃𝑓𝑟𝑜𝑚 ∙ (𝑛 − 𝑖 − 1) + 𝑃𝑡𝑜 ∙ 𝑖

𝑛 − 1
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𝑖 – index of the current section (from 0 to n-1) 

Calculation of rock heat distribution 

To obtain the picture of heat distribution inside the rock strata and the air temperature in the airway 

at any moment of the simulation period, a user should create a named element called "heat 

distribution", which will keep all calculation results. By default, a new model already has one element 

with the end time of one day, although this element does not contain any results yet. A user should 

rename this element and set a proper end time, and then everything is ready for simulation (Calculate 

button). 

 

During simulation, the specified ventilation modes are applied in accordance with their duration and 

sequence. For example, if there are three ventilation modes of one month each, and the end time of 

simulation is 60 days, then only the first two modes are used. If the end time exceeds the total 

duration of all ventilation modes, then the final mode is applied until the end of the simulation. 

To compare simulation results for different input parameters and end times, the application allows 

the user to store calculation results separately. A new “heat distribution” can be added with the Add 

Heat Distribution button. 

 

Displaying calculation results 

When the simulation of heat exchange is over, its results are displayed in a special form, which can 

be opened with the Show Results button on the corresponding “heat distribution”. The first tab of this 

form displays the rock strata temperature in the rings around the airway and the air temperature in 

the longitudinal sections (upper line). Temperature colors can be varied by changing the limiting 

values on the right color bar. When a mouse cursor is pointed at a segment with the rock strata 

temperature, a tooltip with the exact rock strata temperature (Rock Т), ring distance from the airway 

center R, width of the selected layer ∆𝑅 and the location of the ring along the airway in percentage 𝐿 

appears. 
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More detailed information about the air temperature is available on the corresponding tab. 

 

There is also a tab with the chart of the airway's walls temperature. 
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Network heat model 

Creating a new model 

New network heat models are created with the Create Model button on the Heat ribbon tab. 

 

Then a dialogue box listing the model parameters appears. There a user can specify the model name. 

 

All created heat models are displayed on the Heat ribbon tab. 
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Basic principles of simulation 

Heat simulation model is an advanced model of ventilation in a mine. It calculates air quantities with 

regard to different factors, as well as other air parameters, such as gas concentration, temperature 

and humidity of air. 

To do this, the air in airways is divided into elementary volumes for the air in each airway to move the 

length of one elementary volume per the chosen step of simulation time. That is, the length of 

elementary section (volume) 𝐿𝑖  is described by the following formula. 

𝐿𝑖 = (𝑖𝑛𝑡𝑒𝑔𝑒𝑟)
𝑄

𝑆
∙ 𝐿 

𝑄 – air quantity in the airway 

𝑆 – cross-sectional area of airway 

𝐿 – airway length 

 

For example, the above-mentioned network is a junction of two airflows of 20 and 40 cub. m. per sec. 

traveling along the airways of 10 sq. m. in cross-sectional area, with their further joint movement 

along the airway of 20 sq. m. in cross-section. Let the step of simulation time equal to one second. 

Q=60, S=20, L=10 
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Then the upper left airway should have five elementary volumes, while the lower left airway should 

have only two volumes (since this number is rounded to an integer). 

 

In this case, it is sensible to suggest that all parameters of each volume are uniform, and they are 

changed only with the relocation of the volume. Then to obtain a more precise picture, the time 

increment can be shortened thus creating a larger number of elementary volumes, or can be extended 

to speed up the calculation. The only issue is that for very small air quantities the application must 

create a great number of sections, that is why the software excludes from simulation all airways with 

the quantity of 0.1 cub. m. per sec. and less. The minimum non-zero air quantity can be changed in 

the properties of heat model. 

 

There is one more issue: the application should select at least one elementary volume of air in each 

airway participating in simulation, which means that the time increment cannot always be as long as 

a user might wish it to be. If a network has short airways with large air quantities, then in this case 

the time increment is limited by a very small value, which may significantly slow the calculation for 

long time intervals. In this case, a user can set that no coercion of time increment is required. As a 

result, at least one elementary volume of air is surely to be selected in all airways, although the air 

velocity may differ from the actual one in case of short airways with large quantities. That is why a 

user must monitor such an assumption not to result in significant distortion of simulation results. 

Overall, the process of heat simulation is as follows. Model time increases discretely in accordance 

with the chosen time increment. At each step air quantities in the airways are recalculated, and the 

air in the airways is divided into volumes, because quantities in the airways may change. Then heat 

parameters of the volumes at the previous simulation step are used as the basis for calculating the 
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parameters of the volumes at the next step. In the simplest case, a heat parameter Tnew for a new 

volume with index 𝑖 is taken from the volume of old division, and the following formula is applied. 

𝑇𝑛𝑒𝑤[𝑖] = 𝑇𝑜𝑙𝑑[𝑖 ∙
𝑛𝑜𝑙𝑑

𝑛𝑛𝑒𝑤
] 

𝑛𝑜𝑙𝑑  – number of volumes in the airway at the previous simulation step 

𝑛𝑛𝑒𝑤 – number of volumes in the airway at the current simulation step 

However, this method leads to “ledges” in previously smoothly changing heat parameters when the 

volume number increases. Another method of interpolating the data from the previous step can be 

applied instead. 

 

If 𝑛𝑜𝑙𝑑  is the old number of volumes, then the distance between their centers is calculated as follows. 

∆𝑙𝑜𝑙𝑑_𝑐𝑒𝑛𝑡𝑒𝑟 =
1

𝑛𝑜𝑙𝑑 − 1
 

Then the location of the volume center with index 𝑖 is identified, 

𝑙𝑖_𝑐𝑒𝑛𝑡𝑒𝑟 =
𝑖 + 0.5

𝑛𝑛𝑒𝑤
 

followed by the calculation of the indices of the nearest old volumes to the left and to the right. 

𝑗𝑜𝑙𝑑_𝑙𝑒𝑓𝑡 = (𝑖𝑛𝑡𝑒𝑔𝑒𝑟)
𝑙𝑖_𝑐𝑒𝑛𝑡𝑒𝑟

∆𝑙𝑜𝑙𝑑_𝑐𝑒𝑛𝑡𝑒𝑟
 

𝑗𝑜𝑙𝑑_𝑟𝑖𝑔ℎ𝑡 = 𝑗𝑜𝑙𝑑_𝑙𝑒𝑓𝑡 + 1 

Besides, the distances to the centers of the nearest old volumes are found as well. 

𝑆𝑜𝑙𝑑_𝑙𝑒𝑓𝑡 = 𝑙𝑖_𝑐𝑒𝑛𝑡𝑒𝑟 − 𝑗𝑜𝑙𝑑_𝑙𝑒𝑓𝑡 ∙ ∆𝑙𝑜𝑙𝑑_𝑐𝑒𝑛𝑡𝑒𝑟 

𝑆𝑜𝑙𝑑_𝑟𝑖𝑔ℎ𝑡 = 𝑗𝑜𝑙𝑑_𝑟𝑖𝑔ℎ𝑡 ∙ ∆𝑙𝑜𝑙𝑑_𝑐𝑒𝑛𝑡𝑒𝑟 − 𝑙𝑖_𝑐𝑒𝑛𝑡𝑒𝑟 

Then a new value of heat parameter 𝑇𝑛𝑒𝑤 for a volume with index 𝑖 is calculated with the following 

formula. 
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𝑇𝑛𝑒𝑤[𝑖] =

𝑇𝑜𝑙𝑑[𝑗𝑜𝑙𝑑_𝑙𝑒𝑓𝑡]
𝑆𝑜𝑙𝑑_𝑙𝑒𝑓𝑡

+
𝑇𝑜𝑙𝑑[𝑗𝑜𝑙𝑑_𝑟𝑖𝑔ℎ𝑡]

𝑆𝑜𝑙𝑑_𝑟𝑖𝑔ℎ𝑡
 

1
𝑆𝑜𝑙𝑑_𝑙𝑒𝑓𝑡

+
1

𝑆𝑜𝑙𝑑_𝑟𝑖𝑔ℎ𝑡

 

This method of interpolation of heat parameters aims to achieve smoothness in changes with sharp 

increase in the number of the volumes, although this slows the simulation process. That is why if the 

quantities in the airways change insignificantly during the simulation, then it is advisable to disable 

this option. 

Heat parameters in the volumes change due to the influence of different factors during every 

simulation time increment. Then at the end of iteration, volumes in each airway move one position 

towards the airflow. At the places of airflow mixing heat parameters in the volumes are recalculated. 

 

For example, on the above-mentioned schema heat parameters are adjusted with regard to air mixing 

in the volume colored blue. For such factors, as the temperature and humidity of air, gas 

concentration, heat parameters are adjusted as follows. 

𝑇𝑚𝑖𝑥𝑒𝑑 =
∑𝑄𝑖

𝑖𝑛𝑝𝑢𝑡 ∙ 𝑇𝑖

∑𝑄𝑖
𝑖𝑛𝑝𝑢𝑡

 

𝑇𝑚𝑖𝑥𝑒𝑑 – value of temperature, absolute air humidity or gas concentration after the airflows have 

been mixed 

𝑄𝑖
𝑖𝑛𝑝𝑢𝑡 – quantity of the 𝑖-th mixing airflow 

𝑇𝑖 – value of the corresponding heat parameter in the 𝑖-th mixing airflow 

Besides, both the temperature and humidity of air must additionally be coordinated after the air has 

been mixed to guarantee that the relative air humidity does not exceed 100% for the calculated 

temperature. This process is described in more details in the chapter devoted to the moisture-

emission sources. 
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Factors in heat simulation 

The type of quantities used in the model is the most important factor influencing the simulation 

process. By default, airflow calculation, which should give required quantities in the airways, is 

performed every simulation step. However, this approach is of no use, if quantities in the airways do 

not change. With this option disabled air quantities are calculated only once at the beginning of 

simulation, and then in all other iterations the same quantities are used. 

 

Very often, however, the airway network is not ready for airflow calculation. For example, there may 

be only one section of network corresponding to the mine's panel, where the microclimate should be 

predicted. In this case, it is easier to apply the algorithm of quantity distribution, and then to use 

these quantities in heat model. To do this, the Use measured air quantities option should be enabled, 

and the air quantities will not be calculated at all. 

 

Besides, together with the option of air recalculation the Use natural ventilation pressures and The 

air is persistent options are unchecked, because they are useless for constant quantities. 

Using natural ventilation pressure means adjustments of quantities in the airways with the regard of 

current thermal pressures. This happens in the same way, as it is done in ventilation simulation, the 

difference is that in heat modeling the air temperature is calculated in every elementary volume of air 

inside an airway, rather than is set in the airway's nodes, and it can be changed during the simulation 

process. 

As far as the air persistence is concerned, it is used to smooth quick changes in quantities. For 

example, without air persistence quantities in the airways would instantaneously change when the 

main fan is reversed. However, with air persistence enabled ventilation simulation is performed with 

additional pressures ∆𝑃𝑖𝑛𝑒𝑟𝑡𝑖𝑎 described by the following formula. 
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∆𝑃𝑖𝑛𝑒𝑟𝑡𝑖𝑎 =
𝜌 ∙ 𝐿 ∙ (𝑄𝑐𝑢𝑟𝑟𝑒𝑛𝑡 − 𝑄𝑝𝑟𝑒𝑣𝑖𝑜𝑢𝑠)

𝑔 ∙ 𝑆 ∙ ∆𝑡
 

𝜌 – air density 

𝐿 – airway length 

𝑄𝑐𝑢𝑟𝑟𝑒𝑛𝑡 – air quantity in the airway at the current step of simulation 

𝑄𝑝𝑟𝑒𝑣𝑖𝑜𝑢𝑠 – air quantity in the airway at the previous step of simulation 

𝑔 – gravity acceleration 

𝑆 – cross-sectional area of airway 

∆𝑡 – simulation time increment 

As a result, the quantities achieve their target values with certain time delay. 

As for the set of heat parameters, which should be monitored for each elementary volume of air in 

airways, each parameter is selected by an option. 

 

With any heat parameter disabled, memory and processor time are freed, that is why it is helpful to 

disable all parameters unimportant for the current task. 

When air temperature saving is enabled there are additional options available. The first option 

enables or disables the changes of air temperature due to heat exchange with heat-emission sources 

placed on the schema. This option can be used, for example, to consider the influence of fires, 

combustion engines, air-coolers, etc. The second option determines whether heat exchange with 

airways’ walls should be simulated. The third one enables air heating due to autocompression. The 

temperature is adjusted in the same way, as for the model of heat exchange with rock strata; the 

difference is that elevations are set in the property panel of airway end nodes. 
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As for the moisture-emission sources, with them being enabled the air humidity is monitored, 

including the case of the moisture exchange with the airways walls. The option of gas-emission 

sources switches on or off both saving the gas concentration in the airways and gas exchange with 

the corresponding sources. The concentration of only one unknown gas is simulated. 

Heat model initialization 

There are two ways to initialize airway parameters at the beginning of simulation. The first method 

presupposes the usage of the parameters set on the schema. 

 

For example, air temperatures in elementary volumes can be determined by air temperatures in 

airways’ end nodes. 
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In this case, the following formula is used. 

𝑇𝑖
0 =

𝑇𝑓𝑟𝑜𝑚 ∙ (𝑛 − 𝑖) + 𝑇𝑡𝑜 ∙ (𝑖 + 1)

𝑛 + 1
 

𝑇𝑖
0 – initial air temperature in the 𝑖-th volume of airway 

𝑛– number of volumes selected in the airway 

𝑇𝑓𝑟𝑜𝑚 – air temperature at the start node of airway 

𝑇𝑡𝑜 – air temperature at the end node of airway 

As far as the air humidity is concerned, it is always initialized based on the value specified as the 

humidity of the atmospheric air. Gas concentration is supposed to equal zero by default, although 

this value can also be edited in the atmosphere parameters. 

 

The second way to initialize parameters is to use the results of another heat simulation. In this case, 

the parameters of volumes at the end time of the previous model are considered the initial parameters 

for the current one. Moreover, the current model can be taken as a previous model for itself, provided 

heat simulation has already been performed for it. 

 

Parameters of atmosphere 

If an airway end node is connected with the atmosphere, then the heat model always applies 

parameters of atmosphere for the volumes bordering this node along the direction of airflow. For 

example, gas concentration in the atmosphere is considered equal to zero by default. As far as the 

temperature and humidity of air are concerned, they are defined as constant values unchanged in 

time. Such an assumption works very well for short intervals of simulation time. 
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If simulation is carried out for the intervals from twelve hours to several days or even from one month 

of simulation time, then it is impossible to neglect the fluctuations of atmosphere parameters. In the 

first case, a user must set day fluctuations of temperature and humidity of air for the time moments 

with a two-hour interval. 

 

In the second case, only averaged atmosphere parameters are entered for each of twelve months of 

year, because day fluctuations neutralize each other inside these time intervals. 

 

Heat- and gas-emission sources 

With the option Use local heat sources enabled the air temperature in airways can be modified due to 

heat exchange with heat-emission sources on the schema, while gas concentration is traced with the 
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option Use local gas sources. All these sources must be placed on the schema beforehand (category 

Sources of Heat and Gas in the gallery of equipment). 

 

All heat sources are divided into two categories: general sources with the parameters based on simple 

formulas and special sources. The category of simple sources includes the heater and the cooler with 

their air heating and cooling power specified directly. 

 

In this case, to recalculate the air temperature in the volumes bordering a heater or a cooler the 

following formula is applied. 

𝑇𝑖
𝑛+1 = 𝑇𝑖

𝑛 + 𝐿𝑝𝑜𝑟𝑡𝑖𝑜𝑛 ∙
𝑊𝑝𝑎𝑟𝑡 ∙ ∆𝑡

𝑐 ∙ 𝜌 ∙ 𝑆 ∙ 𝐿𝑝𝑎𝑟𝑡
 

𝑇𝑖
𝑛+1 – temperature in the 𝑖-th volume after heat exchange with the heat-emission source 

𝑇𝑖
𝑛 – temperature in the 𝑖-th volume before heat exchange with the heat-emission source 

𝐿𝑝𝑜𝑟𝑡𝑖𝑜𝑛 – portion (from 0 to 1) of heat exchange area of the heat-emission source that is shared by 

the 𝑖-th volume 

𝑊𝑝𝑎𝑟𝑡 – heating (cooling) power of heat-emission source per length of one volume 

∆𝑡 – duration of heat exchange 

𝑐 – specific heat capacity of air 

𝜌 – air density 

𝑆 – cross-sectional area of airway 

𝐿𝑝𝑎𝑟𝑡 – length of one volume 

To calculate 𝐿𝑝𝑜𝑟𝑡𝑖𝑜𝑛the application finds the locations of borders of heat-emission source on the 

airway: 𝐿𝑠𝑡𝑎𝑟𝑡  and 𝐿𝑒𝑛𝑑. 

1) By default, the borders of source are indicated as merging with the borders of airway. 

𝐿𝑠𝑡𝑎𝑟𝑡 = 0 

𝐿𝑒𝑛𝑑 = 1 

2) If the length of source is less than the length of airway, then the location of source center 

𝐿𝑐𝑒𝑛𝑡𝑒𝑟is calculated. 

𝐿𝑐𝑒𝑛𝑡𝑒𝑟 = 𝐿𝑟𝑒𝑙𝑎𝑡𝑖𝑣𝑒 ∙ 𝐿𝑟𝑖𝑏 
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𝐿𝑟𝑒𝑙𝑎𝑡𝑖𝑣𝑒 – relative location of source along the length of airway (from 0 to 1) 

𝐿𝑟𝑖𝑏 – airway length 

a. If the source does not fit the airway to the left (𝐿𝑐𝑒𝑛𝑡𝑒𝑟 −
𝐿𝑠𝑜𝑢𝑟𝑐𝑒

2
< 0, 𝐿𝑠𝑜𝑢𝑟𝑐𝑒 – length 

of source) 

𝐿𝑒𝑛𝑑 =
𝐿𝑠𝑜𝑢𝑟𝑐𝑒

𝐿𝑟𝑖𝑏
 

b. If the source does not fit the airway to the right (𝐿𝑐𝑒𝑛𝑡𝑒𝑟 +
𝐿𝑠𝑜𝑢𝑟𝑐𝑒

2
> 𝐿𝑟𝑖𝑏) 

𝐿𝑠𝑡𝑎𝑟𝑡 = 1 −
𝐿𝑠𝑜𝑢𝑟𝑐𝑒

𝐿𝑟𝑖𝑏
 

c. If the source entirely fits the airway 

𝐿𝑠𝑡𝑎𝑟𝑡 = 𝐿𝑟𝑒𝑙𝑎𝑡𝑖𝑣𝑒 −
𝐿𝑠𝑜𝑢𝑟𝑐𝑒

2 ∙ 𝐿𝑟𝑖𝑏
 

𝐿𝑒𝑛𝑑 = 𝐿𝑟𝑒𝑙𝑎𝑡𝑖𝑣𝑒 +
𝐿𝑠𝑜𝑢𝑟𝑐𝑒

2 ∙ 𝐿𝑟𝑖𝑏
 

3) If the source is longer than the length of airway, then the borders of source are cut to the 

airway's size. 

Unless otherwise specified, the length of source 𝐿𝑠𝑜𝑢𝑟𝑐𝑒 is considered equal to two meters.  

When the borders 𝐿𝑠𝑡𝑎𝑟𝑡  and 𝐿𝑒𝑛𝑑are found, it is possible to identify the heating power per length of 

one volume. 

𝑊𝑝𝑎𝑟𝑡 =
𝐿𝑝𝑎𝑟𝑡

(𝐿𝑒𝑛𝑑 − 𝐿𝑠𝑡𝑎𝑟𝑡) ∙ 𝐿𝑟𝑖𝑏
∙ 𝑊 

𝐿𝑝𝑎𝑟𝑡 – length of one volume in the airway 

𝑊 – given heating power 

Then, the application calculates 𝐿𝑝𝑜𝑟𝑡𝑖𝑜𝑛. 

1) If the source is to the right (𝐿𝑝𝑎𝑟𝑡_𝑒𝑛𝑑 < 𝐿𝑠𝑡𝑎𝑟𝑡), then 𝐿𝑝𝑜𝑟𝑡𝑖𝑜𝑛 = 0. 

2) If the source is to the left (𝐿𝑝𝑎𝑟𝑡_𝑠𝑡𝑎𝑟𝑡 > 𝐿𝑒𝑛𝑑), then 𝐿𝑝𝑜𝑟𝑡𝑖𝑜𝑛 = 0. 

3) If the volume is entirely inside the source (𝐿𝑠𝑡𝑎𝑟𝑡 ≤ 𝐿𝑝𝑎𝑟𝑡_𝑠𝑡𝑎𝑟𝑡 and 𝐿𝑝𝑎𝑟𝑡_𝑒𝑛𝑑 ≤ 𝐿𝑒𝑛𝑑), then 

𝐿𝑝𝑜𝑟𝑡𝑖𝑜𝑛 = 1. 

4) If the source goes outside the border of volume to the right (𝐿𝑒𝑛𝑑 > 𝐿𝑝𝑎𝑟𝑡_𝑒𝑛𝑑), then 

𝐿𝑝𝑜𝑟𝑡𝑖𝑜𝑛 =
𝐿𝑝𝑎𝑟𝑡_𝑒𝑛𝑑 − 𝐿𝑠𝑡𝑎𝑟𝑡

𝐿𝑝𝑎𝑟𝑡_𝑒𝑛𝑑 − 𝐿𝑝𝑎𝑟𝑡_𝑠𝑡𝑎𝑟𝑡
 

5) If the source goes outside the border of volume to the left, then 
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𝐿𝑝𝑜𝑟𝑡𝑖𝑜𝑛 =
𝐿𝑒𝑛𝑑 − 𝐿𝑝𝑎𝑟𝑡_𝑠𝑡𝑎𝑟𝑡

𝐿𝑝𝑎𝑟𝑡_𝑒𝑛𝑑 − 𝐿𝑝𝑎𝑟𝑡_𝑠𝑡𝑎𝑟𝑡
 

The above-mentioned method provides reliable results even with a very small number of selected 

volumes. 

 

In case of fire, the power and the length are defined, then the same formula, as in case of heater, is 

used, the difference is that in case of fire 𝐿𝑠𝑜𝑢𝑟𝑐𝑒 is considered equal the user-defined length of fire, 

rather than two meters. 

 

For a combustion engine, the heating power is described by the following formula. 

𝑊 =
𝑃𝑐𝑜𝑛𝑠𝑢𝑚𝑝𝑡𝑖𝑜𝑛 ∙ 𝐶𝑐𝑜𝑚𝑏𝑢𝑠𝑡𝑖𝑜𝑛 ∙ 1000

3600
 

𝑃𝑐𝑜𝑛𝑠𝑢𝑚𝑝𝑡𝑖𝑜𝑛 –fuel consumption 

𝐶𝑐𝑜𝑚𝑏𝑢𝑠𝑡𝑖𝑜𝑛 – specific heat of combustion 

Moreover, the fuel consumption is not set explicitly, but is calculated with the following parameters. 

𝑃𝑐𝑜𝑛𝑠𝑢𝑚𝑝𝑡𝑖𝑜𝑛 = 𝑊𝑒𝑛𝑔𝑖𝑛𝑒 ∙ 𝑝𝑐𝑜𝑛𝑠𝑢𝑚𝑝𝑡𝑖𝑜𝑛 ∙ 𝑓𝑖𝑟𝑟𝑒𝑔𝑢𝑙𝑎𝑟𝑖𝑡𝑦 

𝑊𝑒𝑛𝑔𝑖𝑛𝑒 – rated power of combustion engine 

𝑝𝑐𝑜𝑛𝑠𝑢𝑚𝑝𝑡𝑖𝑜𝑛 – brake specific fuel consumption 

𝑓𝑖𝑟𝑟𝑒𝑔𝑢𝑙𝑎𝑟𝑖𝑡𝑦 – dimensionless coefficient regarding irregularities in the engine's work 

In case of combustion engine, the length of heat source is considered equal to two meters. 

What is more, the combustion engine can also be a consumer of oxygen, if the gas being calculated 

in the model is considered to be oxygen. 
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By default, the engine does not affect gas concentration in the airway, although with the respective 

option enabled the gas consumption rate is described by the following formula. 

𝐸𝑒𝑚𝑖𝑠𝑠𝑖𝑜𝑛 = −
𝑃𝑐𝑜𝑛𝑠𝑢𝑚𝑝𝑡𝑖𝑜𝑛 ∙ 𝑚𝑜𝑥𝑦𝑔𝑒𝑛

𝜌𝑎𝑖𝑟 ∙ 3600
 

𝐸𝑒𝑚𝑖𝑠𝑠𝑖𝑜𝑛 – oxygen consumption rate 

𝑃𝑐𝑜𝑛𝑠𝑢𝑚𝑝𝑡𝑖𝑜𝑛 – average fuel consumption in kg per hour 

𝜌𝑎𝑖𝑟 – air density 

𝑚𝑜𝑥𝑦𝑔𝑒𝑛 – oxygen mass required to burn one kg of fuel (taken to be 14.42 kg oxygen per 1 kg of fuel) 

   

In the case of conveyor, all consumed electrical power of the drive is eventually heat emitted by 

different parts of the conveyor. By default, the application assumes that the drive emits 15% of its 

rated power, while the conveyor belt emits 85%. However, these values can be set on the properties 

panel of the corresponding objects. As for the rest, the simulation is the same as in the case of 

standard heat-emission sources.  

 

As far as the gas-emission sources are concerned, the length of source and the gas emission intensity 

are set by the user. The gas concentration in each volume of airway is recalculated as follows. 

𝐶𝑖
𝑛+1 =

𝐶𝑖
𝑛 ∙ 𝑉𝑝𝑎𝑟𝑡 + 𝐿𝑝𝑜𝑟𝑡𝑖𝑜𝑛 ∙ 𝑉𝑝𝑎𝑟𝑡_𝑔𝑎𝑠

𝑉𝑝𝑎𝑟𝑡
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𝐶𝑖
𝑛+1 – gas concentration (from 0 to 1) in the 𝑖-th volume after gas emission 

𝐶𝑖
𝑛 – gas concentration (from 0 to 1) in the 𝑖-th volume before gas emission 

𝑉𝑝𝑎𝑟𝑡 – 𝑖-th elementary volume 

𝐿𝑝𝑜𝑟𝑡𝑖𝑜𝑛 – portion (from 0 to 1) of heat exchange area in the current volume 

𝑉𝑝𝑎𝑟𝑡_𝑔𝑎𝑠 – volume of emitted gas 

Besides, the calculation of 𝐿𝑝𝑜𝑟𝑡𝑖𝑜𝑛 is the same, as in case of heat-emission sources. As far as the 

volume of emitted gases 𝑉𝑝𝑎𝑟𝑡_𝑔𝑎𝑠is concerned, it is described by the following formula. 

𝑉𝑝𝑎𝑟𝑡_𝑔𝑎𝑠 =
𝐸𝑒𝑚𝑖𝑠𝑠𝑖𝑜𝑛 ∙ ∆𝑡 ∙ 𝐿𝑝𝑎𝑟𝑡

(𝐿𝑒𝑛𝑑 − 𝐿𝑠𝑡𝑎𝑟𝑡) ∙ 𝐿𝑟𝑖𝑏
 

𝐸𝑒𝑚𝑖𝑠𝑠𝑖𝑜𝑛 –gas emission intensity 

∆𝑡 – duration of gas emission 

𝐿𝑝𝑎𝑟𝑡 – length of one volume 

𝐿𝑠𝑡𝑎𝑟𝑡  – relative location (from 0 to 1) of gas emission area in the airway 

𝐿𝑒𝑛𝑑 – relative location (from 0 to 1) of gas emission area in the airway 

𝐿𝑟𝑖𝑏 – airway length 

And the calculation formulas for heat-emission sources also apply to 𝐿𝑠𝑡𝑎𝑟𝑡  and 𝐿𝑒𝑛𝑑. 

Heat- and gas-emission sources' schedules 

By default, all gas- and heat-emission sources on the schema start functioning at the initial time and 

continue working during the whole process of simulation, which is indicated with the corresponding 

note on the Sources tab in the properties of heat model. 
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Sometimes there is a need to set a schedule for each source individually. In this case, the application 

simulates only those sources that have a user-defined schedule. To create this schedule a user must 

select a source on the schema. Then the schedule of the selected source is added to the list. 

 

By default, the fields with the start and end times of source's work are empty. This means that the 

source functions during the whole time of simulation. If a user sets the initial time only, then the 

source starts working from the specified time up until the end of simulation. If a source must work 

for some time and then stop functioning and then again start working, then it is possible to add 

several schedules for the same source. 

Setting schedules for heat- and gas-emission sources enables simulation of different scenarios of 

fires in a mine. 

Changing fan pressures with time 

Together with schedules of gas- and heat-emission sources a user can also set how fan pressures 

change with time. For example, this is necessary for simulating the reversal of main fan or for any 

other changes in its working mode. To do this, a user, first, should click the Select Fan button on the 

Fans tab in the parameters of heat model, and then select the fan on the schema. 

 

After that, it is possible to fill in the list of fan's pressures connecting them with moments of 

simulation time. There, for all intermediate moments of time fan's pressure is interpolated between 

the specified values. A user can evaluate the fan's pressure curve with the chart displayed above. To 

add a new point a user should just enter the value in the empty field at the bottom of the list. 
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Methods to simulate heat exchange with rock strata 

With the enabled option Use heat from rock strata the air temperature in the volumes is recalculated 

with regard to the heat exchange with surrounding rock strata. There are two main methods to 

calculate this heat exchange: using heat transfer coefficient of the walls and using the coefficient of 

heat exchange. In the first case, the heat transfer coefficient is based on reference values, while it is 

necessary to specify the walls' temperature. In the second case, the walls' temperature is not 

important, while the coefficient of dynamic heat exchange is calculated with the measured air 

temperate drop in the airway for a particular air quantity and virgin rock temperature. 

Applying heat transfer coefficient 

By default, the heat exchange with rock strata is defined by design data specifying the heat transfer 

coefficient of the airway's walls. 

 

This coefficient is always defined for a particular air quantity. When the quantity changes, this 

coefficient is recalculated by the following formula. 

𝛼 = 𝛼0 ∙ (
𝑄

𝑄0
)
0.8

 

𝛼 – heat transfer coefficient for the air quantity 𝑄 
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𝛼0 – user-defined heat transfer coefficient for the air quantity 𝑄0 

With the calculated heat transfer coefficient of the walls, the air temperature in the volumes is found 

using the same formula, which is applied when simulating rock heat distribution. 

𝑇𝑎𝑖𝑟
𝑛 =

𝜌𝑎𝑖𝑟 ∙ 𝑐𝑎𝑖𝑟 ∙ 𝑉𝑎𝑖𝑟 ∙ 𝑇𝑎𝑖𝑟
𝑛−1 + 𝛼 ∙ 𝑆 ∙ ∆𝑡 ∙ 𝑇𝑤𝑎𝑙𝑙

𝜌𝑎𝑖𝑟 ∙ 𝑐𝑎𝑖𝑟 ∙ 𝑉𝑎𝑖𝑟 + 𝛼 ∙ 𝑆 ∙ ∆𝑡
 

𝑇𝑎𝑖𝑟
𝑛  – unknown air temperature in the current volume for the current step of simulation time 

𝑇𝑎𝑖𝑟
𝑛−1 – known air temperature in the current volume for the previous step of simulation time 

𝜌𝑎𝑖𝑟 – air density 

𝑐𝑎𝑖𝑟 – specific heat capacity of air 

𝑉𝑎𝑖𝑟 – current volume 

𝑇𝑤𝑎𝑙𝑙 – temperature of airway's walls in the current volume 

𝑆 – contact area of the current volume with the airway's walls 

∆𝑡 – heat exchange time 

The wall's temperature is calculated with the values set in the airway's nodes (Display -> Heat -> 

Input Data -> Airways’ End Nodes: Indicators -> Wall temperatures). 

 

The following formula is applied. 

𝑇𝑤𝑎𝑙𝑙[𝑖] =
𝑇𝑤𝑎𝑙𝑙_𝑓𝑟𝑜𝑚 ∙ (𝑛 − 𝑖) + 𝑇𝑤𝑎𝑙𝑙_𝑡𝑜 ∙ (𝑖 + 1)

𝑛 + 1
 

𝑇𝑤𝑎𝑙𝑙[𝑖] – temperature of airway's walls near the 𝑖-th volume 

𝑇𝑤𝑎𝑙𝑙_𝑓𝑟𝑜𝑚 – temperature of walls at the start node of airway 

𝑇𝑤𝑎𝑙𝑙_𝑡𝑜 – temperature of walls at the end node of airway 

𝑛 – total number of volumes in the airway 

Adding rock heat distribution models 

Nevertheless, direct setting of airway walls’ temperatures is not always possible, because it requires 

measurements. Besides, such temperatures may differ from air temperatures by some fractions of 

degree, which is very difficult to be noticed by gauges. In this case, it is advisable to use the results 
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of rock heat simulation. On the one hand, it is defined by design data, and, on the other hand, a user 

can calculate the walls' temperature at any model time starting from the airway construction inside 

virgin rock strata. 

 

In this case, it is necessary to select an appropriate model, and then - a calculated result for a 

particular simulation time giving the information about the temperature of airway's walls. A more 

detailed view of a model can be obtained with the corresponding button below. 

 

By default, the walls’ temperature from selected model is considered to remain unchanged during 

further simulation. This may be justifiable for small intervals of time, although with the prolongation 

of these intervals up to at least several months, changing of the rock temperature cannot be 

neglected. In this case, a user should specify that the model is dynamic. 

 

Then for every step of simulation in the network model, a corresponding iteration is taken place in 

the selected model of heat exchange inside rock strata starting from the current heat distribution. In 

this case, a network model of heat exchange with rock strata is created, where a user can select the 

airways that will recalculate rock heat distribution. This speeds up the simulation, because heat 

distribution changes significantly only for a limited number of airways near air supply shafts. For the 

other airways, a user can indicate that heat distribution inside the rock strata is unchanged with no 

damage to the calculation accuracy. 

 

The application also provides an option to save the dynamics of rock heat redistribution. 
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Applying heat exchange coefficient 

Calculation of heat exchange coefficient is an alternative method to simulate heat exchange with 

airway walls. 

 

It is necessary to know the measured air temperature drop in the airway for a particular air quantity 

and virgin rock temperature near the airway. In this case, the heat exchange coefficient 𝐾 is described 

by the following formula. 

𝐾 =
𝜌𝑎𝑖𝑟 ∙ 𝑐𝑎𝑖𝑟 ∙ 𝑄∗

𝑃 ∙ 𝐿
∙ ln (1 + |

𝑇𝑟𝑒𝑠𝑢𝑙𝑡 − 𝑇𝑖𝑛𝑖𝑡𝑖𝑎𝑙

𝑇𝑟𝑜𝑐𝑘
|) 

𝜌𝑎𝑖𝑟– air density 

𝑐𝑎𝑖𝑟– specific heat capacity of air 

𝑄∗ – air quantity for the indicated air temperature drop 

𝑃 – perimeter of airway cross-section 

𝐿 – airway length 

𝑇𝑟𝑒𝑠𝑢𝑙𝑡 – air temperature in the airway after heat exchange with the walls 

𝑇𝑖𝑛𝑖𝑡𝑖𝑎𝑙 – air temperature in the airway before heat exchange with the walls 

𝑇𝑟𝑜𝑐𝑘 – virgin rock temperature near the airway 

The calculated value of the coefficient is displayed on the panel of airway properties. Besides, it is 

possible to display the corresponding indicator on the schema (Display -> Heat -> Input Data -> 

Airways: Indicators -> Heat transfer factors). 

 

With the found value 𝐾 the air temperature in the volumes is recalculated with the following formula. 



95 

𝑇𝑖
𝑛+1 =

𝑇𝑖
𝑛 + 𝑇𝑟𝑜𝑐𝑘(𝑒

𝐾∙𝑃∙𝐿
𝑐𝑎𝑖𝑟∙𝜌𝑎𝑖𝑟∙𝑄 − 1)

𝑒
𝐾∙𝑃∙𝐿

𝑐𝑎𝑖𝑟∙𝜌𝑎𝑖𝑟∙𝑄

 

𝑇𝑖
𝑛+1 – air temperature in the 𝑖-th volume after heat exchange with the walls 

𝑇𝑖
𝑛 – air temperature in the 𝑖-th volume before heat exchange with the walls 

𝑄 – current air quantity in the airway 

Thus, the heat exchange coefficient predicts temperature drops for quantities 𝑄 being different from 

the quantity used for the calculation of 𝐾. 

Moisture-emission sources 

With the Moisture-emission sources option enabled, the air humidity is recalculated in the voumes of 

airways. There, the absolute air humidity 𝐴𝐻 is always taken into account, while the relative air 

humidity 𝑅𝐻 is found by the following formula. 

𝑃𝑠𝑎𝑡𝑢𝑟𝑎𝑡𝑒𝑑 = 100 ∙ 6.1094 ∙ 𝑒
17.625∙𝑇
𝑇+ 243.04  

𝑅𝐻 =
𝐴𝐻 ∙ 𝑅𝑎𝑖𝑟 ∙ (𝑇 + 273.15)

𝑃𝑠𝑎𝑡𝑢𝑟𝑎𝑡𝑒𝑑
∙ 100 

𝑃𝑠𝑎𝑡𝑢𝑟𝑎𝑡𝑒𝑑  – pressure of saturated water vapor at the indicated air temperature 

𝑇 – current air temperature in degrees Celsius  

In contrast to the heat- and gas-emission sources, moisture emission is set as an airway property. 

 

There are two methods to specify the rate of moisture emission. The first method is based on 

measuring the drop of relative air humidity in the airway for a particular air quantity. To do this, the 

measured air humidity is set in each end node of the airway. 
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Then the evaporation rate is calculated with the following formula. 

𝐸 = (𝐴𝐻𝑟𝑒𝑠𝑢𝑙𝑡 − 𝐴𝐻𝑖𝑛𝑖𝑡𝑖𝑎𝑙) ∙ 𝑄∗ 

𝐴𝐻𝑟𝑒𝑠𝑢𝑙𝑡 – result absolute air humidity in the airway 

𝐴𝐻𝑖𝑛𝑖𝑡𝑖𝑎𝑙  – initial absolute air humidity in the airway 

𝑄∗ - air quantity for the indicated air humidity 

After that, the coefficient of moisture emission, which levels the evaporation area and the change of 

rate depending on the current air humidity, is calculated. 

𝑘𝑒 =
𝐸

𝑆𝑠𝑢𝑟𝑓𝑎𝑐𝑒 ∙ (1 −
𝑅𝐻𝑖𝑛𝑖𝑡𝑖𝑎𝑙

100 ) ∙ 𝑃𝑠𝑎𝑡𝑢𝑟𝑎𝑡𝑒𝑑(𝑇)
 

𝑆𝑠𝑢𝑟𝑓𝑎𝑐𝑒 – evaporation area 

𝑅𝐻𝑖𝑛𝑖𝑡𝑖𝑎𝑙 –relative air humidity before evaporation 

𝑃𝑠𝑎𝑡𝑢𝑟𝑎𝑡𝑒𝑑(𝑇) – pressure of saturated water vapor at the air temperature 𝑇 

The area of evaporation is set as a portion of airway's wall area. By default, evaporation is considered 

to occur from the whole area of the walls, that is why the corresponding value equals 100%. 
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The second method to define evaporation rate is to set the coefficient 𝑘𝑒 manually in the properties 

of the airway. 

 

With the coefficient 𝑘𝑒 being set for all airways with evaporation, the air humidity in the volumes is 

recalculated as follows. 

𝐴𝐻𝑖
𝑛+1 = 𝐴𝐻𝑖

𝑛 + 𝑘𝑒 ∙ 𝑆𝑠𝑢𝑟𝑓𝑎𝑐𝑒 ∙ (1 −
𝑅𝐻𝑖

100
) ∙ 𝑃𝑠𝑎𝑡𝑢𝑟𝑎𝑡𝑒𝑑(𝑇𝑖) ∙

∆𝑡

𝑉𝑖
 

𝐴𝐻𝑖
𝑛+1 – absolute air humidity after evaporation in the 𝑖-th volume 

𝐴𝐻𝑖
𝑛 – absolute air humidity before evaporation in the 𝑖-th volume 

𝑅𝐻𝑖 – relative air humidity in the i-th volume before evaporation 

∆𝑡 – duration of moisture exchange 

𝑉𝑖 – selected air volume 

Since the evaporation rate approaches zero with relative air humidity being one hundred percent, that 

is why the relative air humidity will never exceed one hundred percent. However, it may be possible 

due to sudden cooling of moisture-saturated air because of air-cooling system being in operation or 

mixing of airflows having different temperatures. In this case, dew may fall accompanied with the 

increase of air temperature. Thus, when recalculating the air temperature in the volumes the absolute 

air humidity is additionally adjusted as follows. 

1) If the air temperature increases, the temperature and humidity must remain unchanged, 

because no dew is expected to fall. 

2) If the air temperature decreases 

a. If the relative air humidity for the current temperature is less than one hundred 

percent, then no adjustment is needed. 

b. If the relative air humidity for the current temperature equals one hundred percent (or 

more), then the amount of dew should be found. The following equation is applied. 
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𝑅𝐻 (𝐴𝐻 − 𝑑𝐴𝐻, 𝑇 +
𝑑𝐴𝐻 ∙ 𝐿𝑤𝑎𝑡𝑒𝑟

𝜌𝑎𝑖𝑟 ∙ 𝑐𝑎𝑖𝑟
) = 100 

𝑅𝐻(𝐴𝐻, 𝑇) – formula to calculate relative humidity 

𝐴𝐻 – unadjusted absolute air humidity 

𝑑𝐴𝐻 – density of fallen dew 

𝑇 – unadjusted air temperature 

𝐿𝑤𝑎𝑡𝑒𝑟  – latent heat of water evaporation 

𝜌𝑎𝑖𝑟– air density 

𝑐𝑎𝑖𝑟– specific heat capacity of air 

With this equation being solved, the adjusted temperature 𝑇∗ and air humidity 𝐴𝐻∗ 

are found. 

𝑇∗ =  𝑇 +
𝑑𝐴𝐻 ∙ 𝐿𝑤𝑎𝑡𝑒𝑟

𝜌𝑎𝑖𝑟 ∙ 𝑐𝑎𝑖𝑟
 

𝐴𝐻∗ = 𝐴𝐻 − 𝑑𝐴𝐻 

Besides, during evaporation the temperature of the non-evaporated moisture decreases. If all such 

shortage of heat is finally compensated by taking the heat from the air passing by (this happens when 

liquid is represented by small drops and evaporates before it reaches the bottom of the airway), then 

the air temperature in the airway should be recalculated after evaporation. 

 

In this case, the air temperature in the volumes should be adjusted as follows. 

𝑇𝑖
∗ = 𝑇𝑖 −

𝐿𝑤𝑎𝑡𝑒𝑟 ∙ 𝑑𝐴𝐻

𝜌𝑎𝑖𝑟 ∙ 𝑐𝑎𝑖𝑟
 

Heat simulation 

For heat simulation, the respective command in the dropdown menu of the model should be used. 



99 

 

The simulation progress is displayed in a special dialog box enabling a user to monitor the current 

time of simulation, the actual increment of simulation time and the memory usage. 

 

The actual increment of simulation time is very important, since it might be chosen very small, if it is 

automatically coerced. In this case, to speed up the calculation it is advisable to disable the coercion 

and to self-monitor the reliability of simulation results. 

Besides, the simulation process produces a great amount of calculated results, which may lead to 

the memory overflow for large networks and long periods of simulation. 

 

To prevent this situation, a user should select larger period between saving the simulation results in 

the model parameters. For example, the increment of simulation time can be of five seconds, while 

the period between savings is of sixty seconds. In this case, the results are stored for every twelfth 

increment of simulation time. 
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In addition to this, a user can specify that the results should be stored only for a particular period 

from the end of simulation process. This drastically lowers the memory usage, if only the final results 

are of interest. 

Besides, a user can choose to limit the maximum number of parts per each airway when saving the 

heat model. 

 

Saving and loading results 

The results of heat simulation are saved in the schema file, which occupies certain amount of time, 

if the simulation is conducted for a long period. 

 

After that, the simulation results are loaded on demand. However, it may be more convenient to 

disable the saving of results completely. This can be especially helpful, when the saving and loading 

times exceed the time of the simulation itself. 

 

Viewing heat simulation results 

If the simulation has been conducted for a heat model, then its results can be viewed with the 

corresponding menu command. 



101 

 

This can also be done by just clicking the button with the model name. Besides, the results of the last 

viewed model are displayed when clicking the View button on the Heat ribbon tab. To quit the view 

mode a user can just click the same button again. 

 

When a heat model is viewed, a field for editing the current simulation time appears on the status bar. 

 

The current simulation time can be changed by either entering its exact value or by dragging the scroll 

bar. After that, the simulation results will be presented just for the selected moment of simulation 

time. 

 

The graphical representation of results is configured by enabling or disabling the options in the 

Display Modes menu on the Heat ribbon tab. 
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Besides, many view modes enable different gradient fills of the airways with the parameters being 

displayed on the side bar. As far as the viewing of simulation results for a particular airway is 

concerned, these results are displayed in separate dialog windows, which appear after double-

clicking the airways on the schema. 

Starting simulation from a particular point 

Sometimes viewing the results of heat simulation reveals that the end time has been chosen to be 

too short. In other cases, a user may need to introduce certain changes on the schema and then 

continue the simulation. This can be done with the corresponding menu item. 
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In this case, the calculation starts from the moment of simulation time specified by the user, rather 

than from the very beginning. 

 

By default, the simulation resumes from the previous end time, but there is an option to specify this 

time manually. 

 

If the simulation resumes at the time that is less than the end time of the previous simulation, then 

all overlapping results are rewritten. 

Displaying part counts 

It is useful to start checking the results of heat simulation by displaying the number of the volumes 

(sections) selected in airways (Heat -> Display Modes -> Part counts). 
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In this case, airways with the least number of sections (less than five), where the simulation results 

may be inaccurate, are colored in red. If there are no airways with less than five sections, then the 

time increment should be made larger, since this will not significantly affect the accuracy. 

Displaying air quantities and air velocities 

All modes that display calculated air quantities and air velocities when viewing heat models show the 

values calculated during heat simulation for the selected moment of time, rather than the results of 

ventilation simulation. 

 

Besides, the dialog window opened by double-clicking an airway displays the chart of changes in air 

quantity in the airway in time. 
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Displaying air temperatures 

As far as the air temperature is concerned, its overall distribution can be viewed by enabling the 

corresponding fill of the airways (Heat -> Display Modes -> Air temperatures). 

 

There, each section of airway receives its own color, thus one airway may have many colors 

depending on the temperature distribution inside it. Besides, within the dialog window opened by 

double-clicking an airway there is the chart of air temperature distribution along the length of airway 

for the selected time. 

 

The exact values of air temperature in airway nodes can be displayed with the corresponding view 

mode (Display –> Heat -> Input Data -> Airways’ End Nodes: Indicators -> Air temperatures). 



106 

 

Displaying heat distribution inside rock strata 

If heat distribution inside rock strata is calculated and saved for an airway, then the heat distribution 

for the current model time is displayed in the dialog window opened by double-clicking on the airway. 
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Displaying humidity and sensible temperature 

With the enabled air humidity, the corresponding distribution on the schema can be displayed by a 

special view mode (Heat -> Display Modes -> Relative humidity). There, the relative (not the absolute) 

air humidity is highlighted, which is calculated with regard to the air temperature. 

 

Changes in humidity can be monitored in detail on the form of simulation results for an airway. 

 

Besides, the temperature, humidity and velocity of air help to calculate the so-called sensible air 

temperature as follows. 

𝑇𝑎 = 𝑇 + 0.33 ∙
𝑅𝐻

100
∙
𝑃𝑠𝑎𝑡𝑢𝑟𝑎𝑡𝑒𝑑(𝑇)

100
− 0.7 ∙ 𝑉 − 4 

𝑇𝑎 – sensible air temperature 

𝑇 – actual air temperature 

𝑅𝐻 – relative air humidity 

𝑃𝑠𝑎𝑡𝑢𝑟𝑎𝑡𝑒𝑑  – pressure of saturated water vapor at the given temperature 

𝑉 – air velocity in the airway 

Thus, with the enabled air humidity the value of the sensible temperature can be displayed together 

with the value of the actual temperature (Heat -> Display Modes -> Sensible air temperatures). 
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Besides, the dialog window containing the simulation results for a particular airway can show both 

temperatures in one chart. 

 

Displaying gas concentration and smoke 

Sometimes it is important to monitor the presence of non-zero gas concentrations in airways on the 

schema. In this case, it is advisable to enable the display of smoke (Heat -> Display Modes -> Smoke). 

 

If a user needs to know the exact value of gas concentration, then they can either enable the 

corresponding view mode on the schema (Heat -> Display Modes –> Gas concentrations), or open 

the dialog window with the simulation results for the airway.  
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Saving air temperatures 

Ventilation simulation uses air temperatures in airway's nodes to calculate natural ventilation 

pressures. However, it is difficult to set the air temperature in each node manually. One of the ways 

to automate this process is to run the Save Air Temperatures command at the moment of viewing 

one of the heat models. 

 

In this case, the air temperature in each node is set with the calculated value from the selected heat 

model for the current simulation time. 

Later saved end node temperatures can help to build a temperature chart by the corresponding 

command on the Ventilation ribbon tab. 
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Smoke prediction for fan’s reversal 

Let us consider a very simple example of applying heat simulation to predict the spreading of smoke 

from fire. The fan is reversed on the 10th minute after fire outbreak. Let the airway network have the 

following topology. 

 

A heat model is created with the end time of 20 minutes and only the gas concentration monitored. 
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Then, the schedule of fan's work is set in order to change its direction in the period from the 9th until 

the 11th minutes. 

 

Then, heat simulation is conducted and the smoke is displayed. As a result, in 9 minutes after the fire 

outbreak the smoke is spread as follows. 
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Then the fan starts reversing, and to the 20th minute the situation with smoke changes completely.  

 

Calculation of gas concentration for air recirculation 

Now let us assume that there is a need to calculate the concentration of gas in a mine with known 

rate of recirculation. The airway network has the following topology. 
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A heat model is created specifying that only gas concentration should be taken into account. Then 

the end time is set equal to 60 minutes to allow the gas to spread. Then the display of gas 

concentration is enabled. 

 

The exact value of concentration can be looked up in the dialog window with simulation results for 

the right airway. 
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Calculation of oxygen consumption by combustion engines 

Modern safety rules require the mine ventilation to be designed in such a way, as to maintain the 

particular minimum value of oxygen concentration. The functioning of combustion engines is 

considered the key factor of oxygen consumption in a mine. In connection with this, let us look at the 

following example. 

 

A few combustion engines with default parameters are placed on the schema. What is more, it is 

specified in the properties of heat model that the calculation should be conducted only for the gas 

concentration in the airways (oxygen, in this case). Besides, the initial gas concentration in the 

atmosphere is set to be equal to 21 percent. 
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In this case, the pattern of changes in oxygen concentration is as follows (with a red line 

corresponding to 21 percent, and a blue line corresponding to 19 percent). 

 

Processing of temperature survey data 

If heat exchange with rock strata is modelled based on actual measurements, then a user should set 

the air temperature for every end node on the schema, as well as the air quantity and the virgin rock 

temperature for every airway. As to the rock temperatures, they can be estimated by elevations of 

end nodes. The point is that such temperature usually increases evenly with decrease of elevation. 

Thus, with the known temperature and elevation of neutral layer, i.e. the layer, starting from which 

the temperature changes evenly, the application can calculate the virgin rock temperature for the 

elevation 𝐻 using the following formula. 

𝑇𝐻 = 𝑇0 +
𝐻0 − 𝐻

𝛥𝑇𝑠𝑡𝑒𝑝
 

𝑇𝐻 – virgin rock temperature for the elevation 𝐻 

𝑇0 – virgin rock temperature of the neutral layer 

𝐻0 – elevation of the neutral layer 

𝛥𝑇𝑠𝑡𝑒𝑝 – geothermal gradient, i.e. the elevation drop resulting in temperature increase of one degree 

Celsius 
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Hence, if elevations of end nodes are set correctly as well as the neutral layer parameters, then virgin 

rock temperatures near the airways can be calculated by the Set Rock Temperatures button on the 

Heat ribbon tab. 

 

 

However, the virgin rock temperature is specified in the properties of airway, that is why it is 

calculated as the average of virgin rock temperatures of airway end nodes. Besides, if the temperature 

of airway surface is equal to the virgin rock temperature, it can also be set by activating the 

corresponding option (Set airway walls temperatures). 

As to the air quantities corresponding to the air temperatures in end nodes, they are copied from the 

calculated air quantities (the Save Airflow button on the Heat ribbon tab), that can be obtained, for 

instance, from the algorithm of airflow distribution. 

 

Measured air temperatures of end nodes saved in the corresponding field can be displayed on the 

schema by a special view mode (Display -> Heat -> Input Data -> Airways End Nodes: Indicators -> 

Measured air temperatures). 
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As to the end nodes that have no measured air temperatures, they can receive ones by the algorithm 

of temperature distribution (the Distribute Temperatures button on the Heat ribbon tab). 

 

This algorithm not only calculates air temperatures in end nodes, but also temperature drops in 

airways, so that after mixing airflows of different temperatures the result temperature is equal to the 

one in the corresponding end node. 

 

In order to check that temperature drops in airways do not contradict temperatures in end nodes, a 

user can enable a certain view mode (Display -> Heat -> Input Data -> Airways’ End Nodes -> Wrong 

temperature deltas). Let us consider the following example. 
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There are two airflows mixing in the middle end node. The temperature of the first one decreases 

from 24 to 22 degrees, as for the second one – its temperature increases from 16 to 18 degrees. 

Thus, the result temperature after mixing is 20 degrees. However, if the temperature drop in the first 

airway is changed from 2 to 3 degrees, then the middle end node is highlighted in red. 

 

It is also important that temperature drops in airways should correspond to virgin rock temperatures. 

For instance, if air in airway gets warm, then its temperature cannot exceed the virgin rock 

temperature. In turn, if air gets cold, then its temperatures cannot drop below the virgin rock 

temperature. There is a special view mode to check that (Display -> Heat -> Input Data -> Airways -> 

Wrong temperature deltas). Let us examine the following example. 

 

There, the air temperature of the airway increases by 5 degrees from 20 to 25 degrees, while the 

virgin rock temperature is equal 30 degrees. However, if the virgin rock temperature is equal 23 

degrees, then the airway is highlighted in red. 

 

As to the algorithm of temperature distribution, its task is to preserve measured air temperatures in 

end nodes, while setting the unknown temperatures and temperature drops in such a way as to 

comply with the mentioned above verifications as well to ensure that some airways have larger 

temperature drops than others. As in the case of pressure drops, the more is the temperature 

resistance, the larger should be its temperature drop. 

The temperature resistance of airway is estimated by the formula that is used to calculate a 

temperature drop based on heat exchange coefficient, which, in the current case, is taken from the 

properties of the algorithm. 
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The value of the coefficient is not very important, because the algorithm does not use the absolute 

values of temperature resistance, but compares such values between each other. However, it is 

recommended to keep the value of the coefficient small. Besides, a temperature drop in an inclined 

airway is greatly influenced by autocompression, the modelling of which can be turned on in the 

properties of the algorithm. 

 

Let us consider the following schema, which has known air quantities and elevations of end nodes. 

Moreover, the air temperature there is measured in two places (indicator 𝑇’): 10 degrees at the 

entrance and 15 degrees at the exit point. 

Then let us set virgin rock temperatures in airways (indicator 𝑇𝑟) based the elevations of end nodes. 
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Then, air temperatures are distributed with autocompression modelling turned off. As a result, 

temperature drops in shafts will be very small. 

 

However, when the autocompression is turned on, the picture is reversed: shafts will have the largest 

temperature drops. 
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